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1 QUICK CARE-W GUIDE   
1.1 Welcome to the CARE-W Prototype  
 
"Rehabilitate the right pipe at the right time!" 
 
 
CARE–W: Computer Aided REhabilitation of Water networks.  
Decision Support Tools for Sustainable Water Network Management.  
 
A research project supported by the European Commission under the fifth FP.  
Thematic Programme: Environmental and Sustainable Development. Project EVK1-CT-
2000-00053.  
 
The CARE-W Partners: 

• SINTEF, Trondheim, Norway 
• NTNU, Trondheim, Norway 
• Insavalor, Villeurbanne, France 
• Cemagref, Antony, France 
• AGAC, Reggio Emilia, Italy  
• University of Bologna, Bologna, Italy 
• University of Ferrara, Ferrara, Italy 
• Vysoke Uceni Technicke v Brne, Brno, Czech Republic 
• Technische Universität Dresden, Dresden, Germany 
• Laboratório Nacional Engenharia Civil, Lisboa, Portugal 
• WRc plc, Swindon, United Kingdom 

 
Official website: http://care-w.unife.it
 

1.2 CARE-W overview 
CARE-W is a computer-based system for water network rehabilitation planning. It 
consists of software dealing with fundamental instruments for estimating the current and 
future condition of water networks, i.e. performance indicators, prediction of network 
failures and calculation of water supply reliability. Furthermore it includes routines for 
estimating long-term investment needs as well as selection and ranking of rehabilitation 
projects. These tools are operated from the CARE-W prototype, a data management 
hub, which controls input and output to all interacting tools and also contains 
presentation facilities for reporting analysis results to the user via graphical or tabular 
means. 
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Figure 1 Overview of CARE-W 

A quick overview of the main CARE-W tools (CARE-W PI, CARE- W FAIL, CARE-
W REL, CARE-W ARP, and CARE-W LTP) is given in Chapter 1.3-1.7.  
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1.3 CARE-W PI 
 
PI – Performance Indicators 
 
This tool enables the network owner to measure the performance of the network against 
a range of key performance indicators. Network development over time can be carefully 
studied, and benchmarking with other networks or between clusters of pipes in a single 
network is just a few mouse clicks away. 
 
The PIs can be presented in different ways, e.g. pictorially using the GIS viewer, in a 
tabular report, or using in-built graphing features of the PI tool such as time series plots. 
The figure below shows a time series plot of two PIs. 

Figure 2 Example of PI presented as a time-series 
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Op15 – Mains rehabilitation 

Figure 3 Example of PI with guidance range 

 
Figure 3 shows an example of a PI presented as a timeserie where the grey filled area in 
the graph indicates the proposed CARE-W guidance range.  
 
PI’s can also be used as input for benchmarking, when two different water networks 
may be compared. 

Figure 4 PI data used for benchmarking between water utilities 

 
For further information see the tool specific help under CARE-W Prototype menubar 
Tools > Performance indicator tool 
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1.4 CARE-W FAIL 
FAIL – FAILure forecasting 
 
Anticipating the future failure rate in the distribution system is a helpful tool for 
rehabilitation and cost planning. The tools are based on statistical analysis of historical 
maintenance and operational data, and predict the failure rate of one particular pipe or 
groups of pipes. Version 1.54 integrates two failure forecasting tools with the CARE-W 
data management hub. 
 

 
Figure 5 Results from CARE-W FAIL 

For further information see the tool specific help under CARE-W Prototype menubar 
Tools > Failure forecasting models 
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1.5 CARE-W REL 
REL – Water supply RELiability 
 
This module assesses the hydraulic service reliability of the distribution system. The 
tool checks the network for week points using an existing hydraulic model, describing 
the result of one or two pipes being out of service (e.g. after a break). Main outputs are 
reliability indices and link importance (Hydraulic Criticality index, HCI). There are 
three alternative tools for calculating hydraulic criticality at the pipe level. The models 
are using different techniques and the absolute values are not comparable. However, the 
relative ranking is comparable.  
 

Figure 6 Example of results from CARE-W REL 

For further information see the tool specific help under CARE-W Prototype menubar 
Tools > Water supply reliability models 
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1.6 CARE-W ARP 
ARP – Annual Rehab Planner 
 
This multi-criterion decision support tool combines results from the CARE-W tools 
with additional information supplied by the user (known as a ‘knowledge base’). This 
outranking procedure enables analysis over the whole network, sectors or clusters of 
pipes in order to make a prioritized list of rehabilitation candidates for an annual 
rehabilitation investment programme. 
 

Figure 7 Overview of the results from the CARE-W ARP module 

 
For further information see the tool specific help under CARE-W Prototype menubar 
Tools > Annual rehabilitation planning 
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1.7 CARE-W LTP 
LTP – Long Term Planning 
 
The LTP module consists of three closely related tools, namely the Rehab Scenario 
Writer for developing consistent scenarios, the Rehab Strategy Manager (based on 
the KANEW software) for simulation of long-term effects of specific rehabilitation 
options and alternative programmes for different pipe classes. Figure 8 shows the long-
term rehabilitation needs for a water company as an example. Finally the Rehab 
Strategy Evaluator  strives to find the best long-term rehabilitation strategy (Figure 9).  
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Figure 8 Illustration of the long-term rehabilitation need for a water company  

 

Figure 9 Illustration of evaluating the best long-term rehabilitation strategy in the Rehab Strategy 
Evaluator  

For further information see the tool specific help under CARE-W Prototype menubar 
Tools > Long Term Rehabilitation Planning 
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2 INTRODUCTION TO CARE-W REHABILITATION PLANNING 
2.1 CARE-W aims 
The CARE-W project aims to develop methods and software that will enable engineers 
of water utilities to define and implement an effective process to manage their water 
supply networks, rehabilitating the right pipelines at the right time.  CARE-W consists 
of a suite of tools, which will help to provide the most cost efficient approach for the 
maintenance of water distribution networks. 

 
The CARE-W project is organised in the following Work Packages (WP): 

• WP1: Construction of a control panel of performance indicators for 
rehabilitation 

• WP2: Description and validation of technical tools 
• WP3: Elaboration of a decision support system for annual rehabilitation 

programmes 
• WP4: Elaboration of long-term strategic planning and investment 
• WP5: Elaboration of the CARE-W prototype 
• WP6: Testing and validation of the CARE-W prototype 
• WP7: Dissemination 
• WP8: Project management 

 
By developing and integrating complementary software that can handle overall analysis 
of network condition, assessment of long-term financial need and selection of specific 
rehabilitation projects, CARE-W intends to give European water suppliers a better 
methodology for a cost-efficient management of drinking water networks. The CARE-
W project is aimed at water utilities, operating companies, local authorities, financial 
institutions and national regulators. 
 

2.2 The CARE-W procedure 
CARE-W is a computer-based system for water network rehabilitation planning. It 
consists of software dealing with fundamental instruments for estimating the current and 
future condition of water networks, i.e. Performance Indicators, prediction of network 
failures and calculation of water supply reliability. Furthermore it includes routines for 
estimating long-term investment needs as well as selection and ranking of rehabilitation 
projects. These tools are integrated and are operated jointly in the CARE-W prototype, 
which also contains facilities for use including database, GIS and in- output routines. 
The results are presented by reports, in tables and by graphics/GIS. 
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Figure 10 Overview of CARE-W 

In addition to the tools shown in the CARE-W Toolkit, CARE-W also provides a cost 
estimating tool for estimation of costs for rehabilitation of the pipes resulting from the 
CARE-W ARP module. The tool is available from the CARE-W menu Tools > Others 
> Rehabilitation Scheme Developer. N.B. ARP results are not required for the RSD to 
run and produce results, though we believe the results are considerably strengthened 
when ARP results are included. 
 

2.3 A rehabilitation planning sequence 
Efficient planning requires the rehabilitation engineer or planner to be in possession of a 
substantial amount of background knowledge and experience on the types of problems 
faced, current performance and possible effective solutions. The engineer must be aware 
of the objectives of rehabilitation for each problem he faces, and apply sound judgement 
using all the tools at his disposal in an appropriate manner. This places a huge burden 
on the engineer when many rehabilitation methods are feasible and there are many 
solutions to improve service delivery to customers. 
  
There are several ways of working with CARE-W depending on the purpose of the 
analysis and the availability of data.  A complete CARE-W rehabilitation sequence can 
be summarised in the following figure: 
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Figure 11 CARE-W procedure 

 
CARE-W covers the items typed in bold (which means all the issues, except for 
rehabilitation technology (partly covered) and the practical implementation of the 
technology in the ground).  
 
How is the system working? What are the problems? Where are the problems? 
The CARE-W PI module can be used for preliminary characterisation, understanding of 
the system and for problem identification. The performance of the system at both 
network, sector and cluster level are identified. The rehabilitation planner can then 
decide on which zones to investigate in more detail. Monitoring of the system 
performance continues after completion of the rehabilitation program to confirm that the 
expected benefits have been achieved and to identify any problem which may develop 
over time. PI’s presented as time series are useful for this purpose. On the CARE-W 
menu, click Tools > Performance indicator tool.  
 
How much money is needed for rehabilitation in the long- term, 10-20 years? Which 
long-term rehabilitation strategy is the best? 
The CARE-W LTP provides tools for analysing future scenarios, forecasting long-term 
rehabilitation needs and choosing the best rehabilitation strategy. After applying this 
module, the rehabilitation planner will know which strategy to choose and the 
investment needed.  
 
Which pipes should be rehabilitated? 
The decision problem for the water utility is how to spend a given annual budget for 
rehabilitation (resulting from the long-term budget) on the most efficient projects. For 
selecting the limited number of pipes for the annual rehabilitation program different 
criteria must be taken into considerations. Generating annual rehabilitation programmes 
is thus a multi criteria task. The CARE-W ARP module uses information from the other 
CARE-W modules CARE-W PI, CARE-W FAIL and CARE-W REL. Links this with 
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information about other aspects (i.e. criteria). After processing the data the final result is 
a prioritised list of potential candidates for rehabilitation.  
 

2.4 How CARE-W can help 
The CARE-W prototype software is a versatile and powerful application, incorporating 
a variety of rehabilitation planning tools. It has the flexibility to allow the rehabilitation 
of networks to be planned at both strategic and tactical levels, or in other words, at 
various levels of complexity: network, zone or pipe. This flexibility is possible because 
of the nature of the tools that form the prototype software. It should be noted that the 
CARE-W prototype software is a tool to help an engineer devise annual and strategic 
rehabilitation plans; it does not, and is not intended to produce the plan itself. 
 

2.5 Scope of this guide 
The scope is to give the user an overview of the possibilities within CARE-W and help 
the user to get started. You will find explanations of the features in CARE-W. Focus is 
on data handling, working with projects and datasets in CARE-W, interactions between 
the CARE-W tools, reporting results and how to use the results.  
In addition to this guide, there exist specific help files for each tool within CARE-W. 
When working with the different tools these files should be studied in order to 
understand how the different tools work, what input data is required and results are 
reported.  
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3 DATA ISSUES 
3.1 Basic requirements 
The data availability influences the way CARE-W Prototype can be used. Some of the 
CAREW modules are more data consuming than others (see Figure 12). The advanced 
user with updated GIS, digital maintenance records, calibrated hydraulic network 
simulation model etc. can use all the functionality CARE-W provides. However, also 
users with fewer data can benefit from CARE-W. Exactly which tools to use should be 
decided on from case to case based on an evaluation of availability and quality of the 
data. However, CARE-W can also have the role as a catalyst to start or improve the 
process of recording data and act as an incentive to store as much data as possible of the 
highest quality.   
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Figure 12 CARE-W rehabilitation planning procedure and the data requirements for the different 
CARE-W tools 

CARE-W FAIL requires detailed information about pipe inventory and failure data. 
CARE-W REL might for large networks (e.g. many pipes) require long simulation times 
(i.e. hours). CARE-W PI and CARE-W ARP are more flexible with respect to data 
requirements. Results from CARE-W FAIL and CARE-W REL are normally used as 
input for CARE-W ARP. 
 

3.2 Preparation 
 
"GIGO": Garbage In = Garbage Out 
 
The results from CARE-W will depend on the quality of the input data. Any analysis 
undertaken using the CARE-W prototype will only be as good as the data used for that 
analysis. In order to produce reliable results the input data has to be checked.  
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CARE-W in its present version does not supply features for automatic quality control of 
input data. It is the user’s responsibility to ensure that valid data are available for import 
into the prototype, i.e. the data are arranged in a consistent and definable manner, data 
types are correct, and data values are meaningful. This should be done before loading 
the data into the CARE-W database. Everyday use is the best way of quality control of 
existing data. However, the most common known data issues are as follows: 
 
Breaks have to be linked to pipes (in some databases the breaks are linked to 
properties). See Chapter 3.3”Common difficulties and problem solving”.  

• Illogical combinations of pipe material, dimensions and installation year (e.g. 
150 mm PVC laid in 1930). Normally the dimension is more certain than 
material and installation year 

• Illogical failure types (e.g. corrosion/rust on plastic pipes) 
• Missing pipe data (e.g. material, year, length or dimension is missing). The 

local database should if possible be updated and corrected. As an alternative 
default values might be used, but it is probably best not to include these pipes 
in the CARE-W database and in subsequent analysis until anomalies has been 
resolved. 

• Failure date before installation year 
• Multiple breaks at the same pipe at the same day 
• Rehabilitation date before installation year 

 
In order to cleanse the database and update several values at the same time the 
Expression builder  can be used (See also Chapter 5.7 Find and select facility). 
Here you have the possibility to update values for a set of pipes, e.g. for all pipes with 
diameter = 133.3 mm change it to 130mm.  
 
In future versions of the CARE-W prototype validation checks on data as they are 
imported into the central database tables will be provided. 
 
For the advanced user, CARE-W has the facility to create customised reports. This will 
allow the data in the project database to be integrated and validated. See Customised 
Reports. 
 

3.3 Common difficulties and problem solving 
In the following session known issues/problems for each of the tools provided with 
CARE-W is listed. Based on the testing of the individual tools and the integrated use in 
the CARE-W Rehab manager we would like to point out some of the potential pitfalls 
and suggested solutions to the problems.  
 
3.3.1 Known issues/problems for CARE-W Rehab Manager/general problems 

and suggested solutions 
For the Tool manager (see chap. 4.6) it is important that correct path for the different 
tools are given. Play special attention to the PI Tools since this is closely linked to the 
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CARE-W database. If an error occurs then the chances are that you have typed an 
incorrect path name for the PI Tool. 
 
If the ‘Help about’ option is the only menu item available for any tool, then CARE-W is 
unable to locate the tool. The reasons for this may be: 

• The tool has not been installed; 
• The location of the tool has not been entered in the Tool Manager, or; 
• An incorrect tool location given in Tool Manager. 

 
The user should also play special attention to the use of decimal separator. The user can 
try to change the settings from using a dot "." instead of a comma ",". This is a general 
comment and applies to several of the tools (i.e. PHM, Poisson, ARP).  
 
 
Problem Solution 
Using the field PipeId during spesification 
in CARE-W causes problems 

While creating a new specification in 
CARE-W the user should not use the 
CARE-W file name "PipeID" but the file 
“userReference” as the key for linking 
fields (for pipes). (See also chap 3.4 for 
more details) 

When viewing information about pipes be 
using the  information button 
sometimes a single pipe is selceted and 
sometimes several pipes are selected. 

Change the "click extent" in the bar that's 
defaulted to 10. Depending on the density 
of pipes this can be reduced or increased. 

 
 
3.3.2 Known issues/problems for CARE-W PI Tool and suggested solutions 
Problem Solution 
Error 1931: „The windows installer 
service cannot update the system file 
c:\winnt\system32\hhctrl.ocx because the 
file is protected by windows. You may 
need to update your operating system for 
the program to work correctly“. 
 

This error does not affect the operation of 
the tool 
 

 
See also the tool-specific help or brief help session for more details about data 
specifications. 
 
3.3.3 Known issues/problems for CARE-W_Fail_Poisson and suggested 

solutions 
Before the analysis starts failures/breaks must be linked to the pipes where they actually 
occur (see Figure 13). If they are not, CARE-W FAIL tools (i.e. PHM and Poisson) is 
not able to run.  
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Figure 13 Illustration of mismatch between ID in GIS and ID in hydraulic model and breaks not 
linked to pipes 

Problem Solution 
Problem installing the tools under Windows XP. Temporary upgrade to 

"Administrator" status during 
installation has been 
suggested. Can also install 
when logged on as "Default 
User" for more widespread 
use. 

Unable to edit modalities. Programme crashes. See chap. 3.3.4 Known 
issues/problems for CARE-W 
Fail PHM and suggested 
solutions for examples of 
errors in the input file to avoid. 
The SDF file can be edited 
manually until it works. 

The Read_Me file requires the directory CARE-
W_POISSON\\Data_Results|Example1 to be set by 
the user before installing the software. A run time 
error occurs when selecting the sdf and mdf files in 
this directory. Sdf and mdf files accessed in CARE-
W_PIOSSON\\POISSON_Data_Results\\Your_dataset 
does not have this error. 

Change the name of 
Data_results folder to 
Poisson_Data_Results. 

 
See also the tool-specific help or brief help session for more details about data 
specifications. 
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3.3.4 Known issues/problems for CARE-W Fail PHM and suggested solutions 
Before the analysis starts failures/breaks must be linked to the pipes where they actually 
occur (see Figure 13). If they are not, CARE-W FAIL is not able to run. This is valid for 
both PHM and Poisson.   
 
The CARE-W FAIL tool, PHM, is sensitive to the format of the data it is supplied with. 
The following rules should be applied when populating the CARE-W database 
(specially when the data is used for PHM but also relevant for Poisson): 

• No fields greater than 15 characters in length.  
• No fields with non-alphanumeric values (e.g. &,-,?,/ are not permitted).  
• No fields with a string of 9s, e.g. 999 or 9999 (reserved value used by PHM). 
• No fields with all null values; 
• If an installation date is unknown is it advisable to give it a sensible, early 

installation date suitable for the material type, and preferably before the start 
of the “observation period” (user-defined start of analysis period); 

• PHM will interpret a space as NR (not rehabilitated) for the C5* column 
(Date of Rehabilitation). 

 
Problem Solution 
Tool sensitive to long 
pathnames/filenames 

In order to avoid this problem to occur the 
user should choose the default path for the 
location of the tools during installation 
(i.e. C:\Care-W_PHM). 

The survive file is empty 
 

Problems with the input files. Check the 
input file for errors. 

Not able to install the tool When running under XP the user must be 
logged in as a local domain administrator 
in order to install the tools. 

The file VB6FR.dll is missing You need the file on your computer. 
Download the file (e.g. from the BSCW).  

 
See also the tool-specific help or brief help session for more details about data 
specifications. 
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3.3.5 Known issues/problems for CARE-W_Rel_Aquarel and suggested 
solutions 

Problem Solution 
Aquarel crashes if not VALID epanet file We recommend you download Epanet 2.0 

for Windows to create and test input files 
prior to running under RelNet. 

For some PCs the following error message 
might appear „a file is missing or invalid“. 
Fiiles of the type *.OCX.   

Download the missing files from the web 
or from the BSCW server under Tool 
Fixes. 

Mismatch between GIS ID and hydraulic 
ID (see problem illustrated in Figure 13). 

The CARE-W Rel tools estimates HCI for 
only the pipes in the hydraulic model. 
Only pipes with a corresponding ID in the 
CARE-W database will have results. 

For a special network in Norway with 
3000 pipes and special combinations of 
pumps, valves etc the tool crashed. 

No solution found yet. 

Problem installing the tools under 
Windows XP. 

Inherent feature of XP/2000. Installations 
should be done under Default User if 
Administrator rights are not granted. 

 
See also the brief help session for more details about data specifications. 
 
 
3.3.6 Known issues/problems for CARE-W_Rel_Relnet and suggested 

solutions 
Problem Solution 
For large networks (the simulations might 
be time consuming (i.e. hours) and fill up 
the diskspace with simulations files. 

Run the simulations on a PC with large 
disk space. 

Computation stops and following message 
appears: "Stream write error" 

Lack of available disk space. Run the 
simulations on a PC with larger disk 
space. 

Mismatch between GIS ID and hydraulic 
ID (see problem illustrated in Figure 13). 

The CARE-W Rel tools estimates HCI for 
only the pipes in the hydraulic model. 
Only pipes with a corresponding ID in the 
CARE-W database will have results. 

 
See also the tool-specific help or brief help session for more details about data 
specifications. 
 
 
3.3.7 Known issues/problems for CARE-W_Rel_F-Reliab and suggested 

solutions 
 
Problem Solution 
Tool sensitive to long 
pathnames/filenames 

In order to avoid this problem to occur the 
user should choose the default path for the 
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location of the tools during installation 
(i.e. C:\F_Reliab). 

Error message: "The language DLL 
\'VB6FR.dll\' could not be found" 

Download the requested files from the 
web or from the BSCW server or contact 
the tool developer. 

Problem installing the tools under 
Windows XP. 

Inherent feature of XP/2000. Installations 
should be done under Default User if 
Administrator rights are not granted. 

Mismatch between GIS ID and hydraulic 
ID (see problem illustrated in Figure 13). 

The CARE-W Rel tools estimates HCI for 
only the pipes in the hydraulic model. 
Only pipes with a corresponding ID in the 
CARE-W database will have results. 

 
See also the tool-specific help or brief help session for more details about data 
specifications. 
 
 
3.3.8 Known issues/problems for CARE-W_ARP and suggested solutions 
Problem Solution 
Not able to manage long long file names. Do not use more than 8 characters for 

directories. See also Readme.txt for ARP 
 
See also the tool-specific help for more details about data specifications. 
 

3.4 Importing data 
Once a new project [empty] has been created and named, CARE-W will prompt for data 
to be imported via the CARE-W menu, Project > Import.. If this is the first time that 
data files of a specific type are to be imported, then a new data import specification 
must be created. A new specification will need to be created for both the mains and 
failure data. The import specifications are stored in the master database (Master.mdb) 
held on the user’s PC in the root directory where the CARE-W software is installed. 
Any specification created using that local copy of the CARE-W software will be 
available for any new project that is created. 
 
Data may be imported to CARE-W from three sources, namely: 

• GIS data (pipe and failure data). The CARE-W software imports GIS asset 
and failure data as shape (*.shp) files.  

• CSV files (comma separated values) 
• Pre-existing tools input files (e.g. SDF/MDF file for Poisson and PHM, 

EPANET input file for RELNET, and so on) 
 
Data may be imported into a project database in any number of steps and at any time. A 
mixture of data sources is also possible, and indeed likely, particularly where data has 
not been digitised or does not relate to a geospatial reference frame.  
 
Before a specification is physically created within the CARE-W software, the user must 
match up their data fields with the CARE-W database fields. Figure 14 shows the 
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Definition of data transfer dialog box. Each of the user fields is assigned to a 
corresponding CARE-W field name.  

Figure 14 Definition for data transfer 

 
When the CARE-W software imports data it will match the field names given in the 
specification with those in the shape files. An exact match between the import 
specification and the field in the shape files is therefore required to ensure data is 
imported.  
 
The user must be aware of this when creating the import specification and should ensure 
that the names that are given to the new fields in the import specification are the same 
as the column headings in the shape files. 
 
The creation process 
The process for creating a specification is as follows: 

• Select Options, Definition of data transfer, GIS, Manage pipe specifications. 
• You can either modify an existing specification or create a new one. In this 

instance a new specification would be required. 
• You will be prompted for a name. 
• Add a new field for each of the user fields contained in the shape files 

(specifically the *dbf file). A quick way to do that would be to copy and paste 
the names from this file into the field name box in the CARE-W software. 

• Each specification will require a primary key field. As mains data is imported to 
the pipe table the key would be the UserReference (not use PipeID which is a 
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internal filedname!). For the failure data the key would be the UserReference 
followed by the EventID. These keys must be created first. 

• Assign a CARE-W field to each new field.  
• Select save when finished. 
• The name originally given to the specification will be displayed, followed (in 

brackets) by the list of user fields it contains. 
• The specification can be modified or deleted at any stage. 
• Repeat the same process for failure data, but select “Manage failure 

specifications” from the Options menu and used the column headings given in 
the corresponding *dbf file. 

 
Importing GIS data 
The next step is to import the GIS data into your new project, as follows: 

• Select Project, Import, User GIS, Pipe data. 
• Select the mains specification you have just created. 
• Select the GIS shape file containing the mains data you wish to import to your 

project. 
• A message will tell you when the GIS data has been imported. Click OK and the 

GIS data will be displayed. 
• Repeat for the failure data, but select Failure data from the Project menu. 

 
The project now contains data for analysis by the CARE-W tools. 
 
 

3.5 SDF and MDF files format 
The CARE-W Fail tools (i.e. Poisson and PHM) require input data to be on a predefined 
format. Two types of files are required, namely a SDF (segment description files) file 
and the MDF (maintenance description files) file. The format and information of these 
files are given below, including: 
 
The pipe co-ordinates from the SDF file are not stored in the CARE-W database. Co-
ordinate information is taken from either EPANET or GIS shape files. 
 
SDF variables: 
 
Variable Description Comment/ table field in CARE-W 

database 
I1 Pipe ID UserReference 
I2 Street Street,road,locality 
I3 Area  
I4 Co-ordinates1   
C1 Length Length 
C2 Diameter Diameter 
C3 Material Material 
C4 Installation Year YearLaid 

                                                 
1 The pipe co-ordinates from the SDF file are not stored in the CARE-W database. Co-ordinate 
information is taken from either EPANET or GIS shape files. 
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C5 Replacement Date (end of use) DateAbandonedReplaced 
C6 Rehab Date Date of rehabilitation 
C7 Internal Protection InternalLining 
C8 External Protection ExternalLining 
C9 Joint Type Joint type 
C10 Depth DepthOfInstallation 
C11-C15  User defined (quantitative)  
C11$-C15$  User defined (qualitative)  
E1 Soil Type Type of Soil 
E2 Traffic Type Traffic in street 
E3 Pipe Location Pavement 
E4 Bedding Type BeddingType 
E5 Pressure Average Working Pressure 
E6  No of Service connections 
E7-E10 User defined (quantitative)  
E6$-E10$ User defined (qualitative)  
 
MDF variables: 
 
Variable Description Comment/ table field in CARE-W 

database 
M1  Pipe ID UserReference 
M2  Failure Date FailureDate 
M3  Failure Type MaintenanceType 
M4  Failure Cause Cause of Failure 
M5  Type of Repair 
M6-M9  User defined (quantitative)  
M5$-M9$ User defined (qualitative)  
 
 

3.6 Procedure for modifying the definition of data transfer 
Under the CARE-W menu Options > Definitions for data transfer the user can 
modify the definition of data transfer (see Figure 15). The data import specification 
determines where data from various file types will be stored in the CARE-W database. 
The specification assigns the variable types in the data files to fields in either the "Pipe" 
or "PipeFailures" tables in the central CARE-W database. 
 
The prototype includes a number of default import specifications, which are based on 
the agreed format for the tools in the CARE-W toolkit. In most cases it should therefore 
not be necessary to modify any of these existing specifications. We recommend that the 
‘Definition of data transfer’ facility is not used for standard data importing. The 
exception to this would be when an SDF or MDF data files contain a number of "user 
defined" variables.  
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Figure 15 Accessing data transfer definition function 

The user can either select a new default specification or modify an existing specification 
 
Selecting a new default specification 
Under Options > Definitions for data transfer > Select new default specification 
new default specifications can be defined (Figure 16).  

Figure 16 Selecting a new default specification dialogue 
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The available import specifications are given in the drop down list. The title of the 
specification describes the variables that are used. When a new specification is selected 
the list of variables is shown in the ‘Current Specification’ box. The names on the right 
hand side of the list are the database fields that the variable has been assigned to. 
Clicking ‘OK’ will make the selected specification the default for all file imports of that 
type, i.e. CreateSDF(I1,C1,C2,C3,C4) will be the default for all SDF imports. 
 
Modifying existing specification  
Under Options > Definitions for data transfer > Modifying existing specification 
existing specifications can be changed (see Figure 17). When this option is selected a 
new specification will be created, based on an existing specification. The following 
dialog box appears: 

Figure 17 Modifying existing specification 

As with the previous dialogue, an existing specification is selected from those available 
in the drop down list. The current specification details are displayed. The ‘Add’ and 
‘Delete’ buttons allow the user to add new variables or delete existing variables from 
this list. 
 
The ‘Add’ button displays the dialogue box shown in Figure 18. 
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Figure 18 Adding new variables 

Select the name of their variable into the box called ‘user name’. Then select the 
database field where you wish the information from this variable to be stored. Clicking 
on the arrow button in between adds this new variable to the list in the ‘Current 
specification’ box. 
 
The user must ensure that the data type of the variable and the database field are 
compatible otherwise an error will occur when the data is imported. The delete action is 
carried out by selecting the variable to be deleted in the ‘Current specification’ list, then 
clicking the arrow on the right hand side. Clicking ‘OK’ will create a new specification, 
named after the variables that it contains. 
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3.7 PI autoload 
CARE-W provides an ‘autoload’ facility which sends data about the active dataset to 
the PI tool for subsequent analysis. The data loaded relates to a user-defined analysis 
period. This facility is intended to reduce the time spent re-entering UI/EI data for 
subsequent PI analyses based on the same dataset, particularly where data values will 
not have changed from one analysis period to the next. Depending on the options 
chosen in the next two dialogs, CARE-W will automatically present the PI tool with a 
dataset with as much ‘default’ information as is sensible. This information may then be 
modified as necessary in the PI tool UI/EI manager.  
 
Any existing time period (if the PI analysis has been conducted previously) may be 
chosen, or a new time period for PI analysis defined (see PI menu structure below). 
[Note that the period for PI analysis may also be changed or created when running the 
PI tool.] 
 

Figure 19 Autoload facility within CARE-W  

Choosing either Select existing period or Define new period will result in the following 
prompt: 
 

Figure 20 Autoload options 

The user must then decide which data to autoload for his PI analysis. He has the choice 
of 

• Loading only the newest* pipe attribute data (corresponds to data stored in the 
project database ‘Pipe’ and ‘PipeFailure’ tables) 

• Loading only the most recent** utility and external information (corresponds 
to UI/EI data stored in the project database ‘PI_UI_EI’ table) 
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• Loading only the newest*  pipe attribute data and then any additional UI/EI 
data known for the most recent** period available 

 
* 'Newest' 
'Newest' means the most up-to-date information available at the beginning of the new analysis period. By convention, if the start 
date of the analysis period is before 1 July , data for pipes up to and including 31 December of the previous year are included. If the 
start date of the analysis period is 1 July or later, data for the whole year in which the analysis starts are included. This convention 
may be changed by advanced users if they wish.  
 
** ‘Most recent’ 
'Most recent' period refers to the first analysis period found, running backwards in time from the start date of the new analysis 
period, whose end-date is not later than that of the new analysis period.   

 
The third option is selected by default as it has the potential to provide the greatest 
volume of information and save the user the greatest amount of time later. 
On clicking OK, the user is presented with a time period selection dialog similar to that 
found in the PI tool: 
 

Figure 21 Timeperiod for PI analysis  

Clicking Autoload will complete the instruction to load the requisite data for PI 
analysis. The PI tool may now be run and autoload data amended as necessary. 
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4 SOFTWARE BASICS 
4.1 Installation 
The CARE-W Prototype consists of a central MS Access 2000 database and a Visual 
Basic 6.0 application for the user interface.  
 
A PC with the following minimum specification will be required to run CARE-W and 
the failure forecasting tools effectively: 
 

• 1 GHz Processor 
• 256 Mb RAM 
• Windows 2000  
• Office 2000 Professional 

 
This is the minimum specification agreed by the CARE-W consortium. It might also run 
for smaller computers, but then more time is required for loading data, and running 
analysis etc. 
 
Pre-Installation 
The PI Tool is closely linked to the CARE-W database and it is important that the PI 
Tool is installed. Start it up to confirm it has successfully installed.  Also make a note of 
the FULL path name to the program e.g. C:\PITool\PITool020.exe. Install any other 
tools you wish to run. Make a note of the full path name to the program. e.g. 
C:\Aquarel\aquarel.exe AND the path you wish to use for data transfer for the product 
e.g. C:\Aquarel\Model. 
 
Installation 
1) Unzip the CARE-W.zip file to a temporary directory 
2) Run the setup file in the temporary directory 
 
 
First time use of CareW.exe 
1) Start the program carew.exe and select the menu item Tools->Tool Manager 
2) Enter the program names and path names for data transfer. 
 
Second and general use of CareW.exe  
Take the menu option Project > New and create a new project.  (If an error occurs then 
the chances are that you have typed an incorrect path name for the PI Tool). Take the 
option Project > import >Pre-existing tool import and import e.g. a Relnet model into 
the project. Exiting and restarting CARE-W should automatically load you project. 
 
After installation, the default if for the project autoload facility to be dis-engaged. If you 
wish CARE-W to automatically load the current project then the autoload facility must 
be activated. See Options menu item. 
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4.2 Running the software 
The CARE-W Prototype is run by clicking on the shortcut placed by the installation 
program on the Start Menu of MS® Windows®. Alternatively, the Run… command on 
the Start Menu can be used in order to run CARE-W.exe from the program folder 
where it has been installed. 
 
The CARE-W shows a splash screen at start-up. The screen has a timer that lasts for a 
few seconds before the program appears. If desired, clicking anywhere on the splash 
screen steps into the program straight away. 
 

Figure 22 CARE-W splash screen 
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4.3 Finding your way around 
The well-known Windows style has been adopted for the program workspace of CARE-
W. The workspace consists of the following elements: 

• The program main window 
• The Menus 
• The Toolbars  
• The Tool manager  

 
The main window is where the dialog boxes, forms, tables CARE-W uses and generates 
are displayed. The menus and the Toolbars are shown below. The format of the user 
interface reflects the principals behind the architecture of the prototype itself. More 
specifically, the interface is designed to allow the user to work with projects and 
datasets within projects. The interface gives direct access to the CARE-W tools and 
provides the facility for importing data to and from these tools. It also provides the 
medium for reporting analysis results.  
 
The menu options and toolbar of the prototype is shown below. The title bar details the 
name of the project that is currently open (in this example, ‘Crissiertest’), the active 
dataset name (‘Uptown’) and the active dataset description (in this case, ‘Central’). 

 
Figure 23 Menubar 

  
 

4.4 Menus 
The menubar located across the top of the program workspace contains a collection of 
menus used to control the program. These include: Project, Dataset, Tools, Options, 
Windows, Reports and Help.  
 
The Project menu contains commands for opening, saving data files, controlling project 
properties and for importing data. 
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Table 1 Project menu 

Level 1 Level 2 Level 3 Description 
New   Creates a new Project.  
Open   Opens an existing database using 

standard Windows Open dialog. 
Note: if the autoload option is set to ‘on’ 
by default, the prototype software will 
open up the last project used. See Project 
Properties dialog 

Save   Saves the properties of the open project.  
Save As   Saves a new open project or renames an 

existing one. 
Project 
properties 

  Accesses the Project Properties dialog.  

Import   Import data into the central database 
tables. 

 User GIS 
(pipe data) 

 Imports GIS data (pipe data) 

 User GIS 
(faliure data) 

 Imports GIS data (failure data) 

 User comma 
seperated 
values () data 

 Imports data in the form of CSV files. 

 Pre-existing 
tool input file 

  

  Aquarel 
(*.inp + 
*.mdb) 

 

  Poisson 
(*sdf.txt + 
*mdf.txt) 

 

  F-Reliab 
(*ndf.txt 
+*hlf.txt) 

 

  PHM 
(*sdf.txt 
+*mdf.txt) 

Opens the relevant file using the standard 
Windows Open dialog. These menu items allow 
the User to import data in the form of files that 
have been pre-formatted for use by the relevant 
tools.  

  Relnet (*.inp)  
  Waterfowl 

(v3) (*.wdf) 
 

Exit   Accesses the Exit dialog. User prompted 
to save on exiting the prototype. 

 

The Dataset menu contains all the functions which allow the user to manipulate 
datasets, such as creating new datasets, opening existing datasets and deleting datasets 
from a project.  
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Table 2 Dataset menu 

Level 1 Description 
New Accesses the New Dataset dialog. 

Allows the user to create a blank dataset.  
Open Accesses the Open Dataset dialog. 

Open an existing dataset from a list of datasets associated with the 
Project. The selected dataset will become the active dataset. 

Save As Renames the active dataset. 
Delete Accesses the Delete Dataset dialog. 

The user will be presented with a list of all datasets in the Project 
that can be deleted.  

Create new from 
selection 

Accesses the New Dataset dialog. 
Allows the user to create a new Dataset from the assets selected in 
the GIS viewer.  

Add selection to 
dataset 

Allows the user to add data to the active dataset using the GIS 
viewer. 

Create new from 
selection 

Accesses the New Dataset dialog. 
Allows the user to create a new Dataset from the assets selected in 
the GIS viewer.  

Remove selection 
from dataset 

Deletes selected data from the active dataset. 

Dataset properties Accesses the Dataset Properties dialog.  
 

Besides access to the Tool manager, the Tools menu also contains direct access to the 
different tools, including tool specific help, internal editing of data, running the tools 
and exporting results back to the CARE-W database.  
 
Table 3 Tool manager menu 

Level 1 Level 2 Level 3 Level 4 Description 
Tool Manager    Accesses the Tool 

Manager dialog 
Help about PI 
Tool 

   

Select existing 
period for 
autoload 

  

Load active 
dataset 
information 

  

Runs the routine to 
automatically load 
relevant data from 
the active dataset.  

Performance 
Indicator tool 

Run   Runs the PI tool 
Failure 
forecasting 
models  

Poisson 
(Assetmap2) 

Help About 
Poisson 

 Accesses Help 
information 
specific to each 
tool 
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Level 1 Level 2 Level 3 Level 4 Description 
Generate All 
Input Files 

 Runs routine to 
generate all the 
input files required 
by the specific 
tool. 

Segment 
Description 
File (SDF) 

Edit Input 
Files 

Maintenance 
Data File 
(MDF) 

Opens the relevant 
input files.  

Run  Runs the tool using 
the input files 
previously 
generated by the 
prototype 

Return 
Results to 
CARE-W 

 The results from 
the tool analysis 
are imported back 
into the central 
database. 

PHM   Level 3 and 4 
menu items as per 
Poisson 

Aquarel   Level 3 menu 
items as per 
Poisson 

F- Reliab   Level 3 menu 
items as per 
Poisson 

Water supply 
reliability 
models 

Relnet   Level 3 menu 
items as per 
Poisson 

Help about 
ARP 

  Accesses Help 
information 

Generate all 
input file 

  Runs routine to 
generate input file 

Edit CSV input 
file 

  Opens the relevant 
input file. 

Annual 
Rehabilitation 
Planning 
 

Run ARP 
module 

  Runs the tool using 
the input file 
previously 
generated by the 
prototype 
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Level 1 Level 2 Level 3 Level 4 Description 
Return results 
to CARE-W 

  The results from 
the tool analysis 
are imported back 
into the central 
database. 

Markov Help about 
Markov 

  

Help about 
Rehab 
Scenario 
Writer 

 Accesses Help 
information 

Generate all 
input files 

 Runs routine to 
generate all the 
input files 

Edit input 
files 

 Opens the relevant 
input files. 

Run Rehab 
Scenario 
Writer 

 Runs the tool using 
the input files 
previously 
generated by the 
prototype 

Rehab Scenario 
Writer 

Return 
results to 
CARE-W 

 The results from 
the tool analysis 
are imported back 
into the central 
database. 

Rehab Strategy 
Manager 

Help about 
Rehab 
Strategy 
Manager 

 Accesses Help 
information 

 Generate all 
input files 

 Runs routine to 
generate all the 
input files 

 Edit input 
files 

 Opens the relevant 
input files. 

 Run Rehab 
Strategy 
Manager 

 Runs the tool using 
the input files 
previously 
generated by the 
prototype 

 Return 
results to 
CARE-W 

 The results from 
the tool analysis 
are imported back 
into the central 
database. 

Long Term 
Rehabilitation  
Planning 

Rehab 
Programme 
Evaluator 

  Menu items as per 
Scenario Writer  
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Level 1 Level 2 Level 3 Level 4 Description 
Epanet   Runs Epanet 

hydraulic 
modelling 
application 

Generate 
cost 

 Runs routine to 
generate cost 

Rehabilitation 
Scheme 
Developer Return 

results 
 The results from 

the tool analysis 
are imported back 
into the central 
database. 

Help about 
Waterfowl 

 Accesses Help 
information 

Generate all 
input files 

 Runs routine to 
generate all the 
input files 

Edit input 
files 

 Opens the relevant 
input files. 

Run 
Waterfowl 

 Runs the tool using 
the input files 
previously 
generated by the 
prototype 

Other 

Waterfowl 

Return 
results to 
CARE-W 

 The results from 
the tool analysis 
are imported back 
into the central 
database. 

 
 
The Options menu contains functions for commands for opening, saving data files, 
controlling project properties and for importing data. 
 
Table 4 Options menu 

Level 1 Level 2 Level 3 Description 
User preferences   Possible auto-load of 

last saved project 
Review lookup codes Pipe 

materials 
 Defining materials  

 Pipe surface 
types 

 Defining surface type 

 Pipe 
bedding 
type 

 Defining bedding 
type 

 Pipe soil 
type 

 Defining soil type 

 Pipe failure  Defining failure type 
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type 
Assign XY co-ordinates 
to failures (where 
unknown) 

   

Definitions for data 
transfer 

SDF Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 MDF Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 NDF Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 HLF Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 CSV Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 GIS Select new default 
specifications 

Define new import 
specification 

  Modify existing 
specifications 

Modify existing 
import specification 

 
 
The Reports menu contains commands for tabular and GIS reports at different level of 
detail (e.g. pipe, sector).  The tabular reports are a supplementary feature to the GIS 
results display.   
 
Table 5 Reports menu 

Level 1 Level 2 Level 3 Description 
Tabular   Accesses the Tabular reports dialog 

listing the available reports (via Excel 
spreadsheet), as follows:  
Strategic Planning– global budget 
Project summary – current performance. 
Dataset summary 
Dataset failure forecasting results 
Dataset hydraulic reliability results 
Dataset PI report 
Dataset pipe rehabilitation plan 

GIS   Display the results in the CARE-W GIS 
viewer. 
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 Sector  View results at less than pipe-level 
detail in GIS Viewer (PI Tool data)  

  Select new time 
period and PI 

Select time period and PI for the 
analysis. 

  Select PI and 
display results for 
current time period 

Select new PI to be displayed. A list of 
available time periods will be displayed  

  Set bands and 
colours for PI 

Define presentation and layout 

 Pipe  View results per pipe in GIS Viewer 
  Select new results 

and dataset and pipe 
attribute 

Select results to be presented 

  Select pipe attribute 
and display results 
for current results 
dataset 

Select pipe attribute for the dataset 

  Set bands and 
colours for pipe 
attribute. 

Define presentation and layout 

 

The Window menu contains the following commands: 
Table 6 Window menu 

Level 1 Description 
Cascade Cascades all open windows inside the program workspace. 
Tile Vertically Tiles all open windows vertically. 
Tile Horizontally Tiles all open windows horizontally. 
Arrange Icons Arranges icons for minimized MDI child forms. 
Show GIS 
window 

Opens GIS window if not already open 

 

The Help menu contains commands for getting help in using the program: 
 
Table 7 Help menu 

Level 1 Description 
General Help Accesses the general CARE-W Help file 
About CARE-W
  

Accesses the About CARE-W dialog with information about 
software version number, copyright and licensing information. 

 
 

4.5 Toolbars 
GIS functions are accessed via the CARE-W GIS toolbar. Most of these functions are 
generic to geographical information systems. All functions are available when the MAP 
folder is active.  
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 Print  

 Show extents  

 Zoom in 

 Zoom out 

 Pan 

 Remove selection 

 Select by point click 

 Select by drawing a line 

 Select by drawing an ellipse 

 Select by drawing a box 

 Select by drawing a polygon 

 Create dataset boundary 

 Add background map 

 Information on selection 

 Accesses Find facility  

 Help 
 
 

4.6 Tool manager 
 
The Tool manager‘s primary function is to control the accessibility of tools by setting 
data types and locations of the input data and application files required to run the tools 
under the CARE-W Prototype. This information is found on the Tools (location) tab 
shown below. In the Tool manager menu the complete path for the individual tools 
(application file) and the path name where the data for each tool is temporally stored 
must be specified. The CARE-W prototype uses these paths before running the 
individual tools and returning data to the CARE-W database and making the data 
available for further analysis. By using the Tool Manager new versions of the individual 
tools can used without reinstalling the complete software. However, this is only valid as 
long as the input-/output format has not been changed. Under the folder Full 
Application Name the complete address of the executing file should be listed. The folder 
Path Names For Tool Names refers to the location where the data files are stored. In 
order to run CARE-W and all the individual tools the Tool manager must be set up 
correct (see example in Figure 24).  
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Figure 24 Tool manager 

  

5 WORKING WITH PROJECTS AND DATASETS 
5.1 Projects 
A CARE-W project is a collection of data items, analyses and results pertaining to an 
area or areas of interest to the CARE-W user. The area of interest may be geographic 
(such as a city network) or thematic (e.g. water quality issues). The notion of a project 
provides a means to work with, and maintain, multiple CARE-W model simulations.  
 

5.2 Creating new projects 
In practical terms, creating a new project will create a new CARE-W database based on 
a pre-defined template database. The user should then save the new project database 
with a memorable and recognisable name. In practical terms, a project is a version of 
the CARE-W database containing all the information relating to a particular model of 
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interest to the user. In order for the prototype to operate, an existing project must either 
be opened or a new project created. 
 
When the Project > New item is selected the Open dialog will be accessed and a blank 
copy of a template database will be selected by default. This project database will 
contain all of the tables required by the prototype software, but they will remain blank 
until data is imported into the project. 
 
Once a new project has been created a Project Properties dialog will be shown (see 
below). The user will be prompted for a project name and description. The Project 
Properties form is also accessed through the CARE- W menu Project > Project 
Properties. This form also provides other useful information about a project, such as 
which input datasets were used, and the names of the results datasets created following 
analysis. 
 

5.3 Datasets 
A CARE-W project in use will contain one or more datasets. A dataset is a user-
specified collection of pipes. All analysis within CARE-W will be carried out on an 
input dataset and, for each simulation, a results dataset will be created. Clearly, the link 
between pipe attribute information and the results from analysis carried out on these 
pipes must be maintained. An electronic analysis history will be kept, and results 
datasets named such that they reference the analysis tool and input dataset used. All 
analysis within the prototype is conducted on the active dataset, which, as the name 
suggests, is the current, selected dataset on which the user is working.   
 
Input datasets may be of three types: network, sector, or cluster. Datasets may only 
belong to one project and are created by selecting pipes. Pipes may be selected for 
inclusion in a dataset in a variety of ways depending on whether geospatial information 
is available or not. A sector is understood as a collection of pipes which have been 
grouped under a reference name, typically an operational or management unit, e.g. 
water supply zone, hydraulic zone, district meter area. A cluster is understood, in 
practice, to mean a geographic clustering or grouping of pipes with one or more 
common attributes (such as age, material, geographical location, etc.) which may or 
may not lie within one sector. A network is understood to be the largest grouping of 
pipes, typically a collection of sectors of a company or municipality. 
 
 

5.4 Creating new datasets 
New datasets are created at the request of the user. The creation of a dataset allows the 
user to filter out unwanted information and focus on the areas of interest. The dataset is 
therefore a convenient mechanism to reference and manage pipe selections and results 
to an appropriate and meaningful level. It is envisaged that the rehabilitation planner 
would wish to investigate any problems in his network at a number of levels of 
complexity, not least in terms of geographic area covered. There are several ways to 
create a new dataset, and these reflect the number of reasons why the user may wish to 
use a new dataset:  
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Table 8 Scenarios for creating new datasets 

Scenario Action 
1. 1. The user may have an existing 

dataset, which he wants to amend but 
retain the original for comparison.  

Use Datset > Save As and rename before 
making changes. 

2. 2. The user may wish to focus his 
analysis on a number of pipes in his 
current dataset.  

Select the pipes of interest (see Find and 
select facility), then use Dataset > Create 
new from selection 

3. 3. The user may wish an empty dataset 
to which he can add pipes. 

Use Dataset > New to create an empty dataset

 
The New and Create New From Selection functions will both access the New Dataset 
dialog, shown below. This dialog allows the user to give the dataset a name, description 
and to set the dataset type. Dataset types are critical to proper use and reporting of 
CARE-W data. 
 
The following procedure should be followed when creating a new dataset: 
 

1) Choose a name for your new dataset. A list of existing datasets is given in the third 
combox box. Enter a description for this new dataset (this is optional). If you do, 
it will be reported in the Dataset properties form and can be updated at any time. 
N.B. The dataset name is fixed once the OK button has been clicked and 
cannot be changed subsequently. 

2) Choose the dataset type. This will affect what you see below. 
a) Choose network if your pipe selection is a large hydraulic network or city, or 

forms the basis for the CARE-W project. Go to step 3. 
b) Choose sector if your pipe selection is a sub-network and is a geographic 

cluster of pipes which forms a water supply zone (WSZ) or district meter area 
(DMA), for example. Go to step 4. 

c) Choose cluster if your pipe selection is either: 
i) a collection of pipes which do not form a complete management unit (such 

as a WSZ or DMA), and/or 
ii) a collection of pipes which have similar characteristics (e.g. same material, 

more than 100 years old, above a certain failure rate threshold)  
Go to step 5. 

3) If you are creating a ‘Network’ type dataset, the dialog will look like that in 
Figure 1. You must tell CARE-W whether the pipe selection you have just made 
constitutes a hydraulically discrete area (such as that in a hydraulic model) or not. 
The option you choose here will affect all datasets which are subsets of this 
network dataset. Choose the option ‘This dataset does not belong to a hydraulic 
model dataset’ ONLY IF YOU ARE SURE the pipe selection is NOT 
hydraulically discrete. Otherwise, leave at the default setting. Go to step 8. 
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Figure 25 Network type selection 

  
4) If you are creating a ‘Sector’ type dataset, you will see the dialog below. You must 

tell CARE-W whether the pipe selection you have just made constitutes a 
hydraulically discrete area (such as that in a hydraulic model) or not.  

 
The option you choose here will: 

 affect all datasets which are subsets of this sector dataset, and 
 determine whether you can inherit results from previous analysis conducted 

at network level. 
a) Choose the option ‘This dataset does not belong to a hydraulic model 

dataset’ ONLY IF YOU ARE SURE the pipe selection is NOT hydraulically 
discrete. Otherwise, leave at the default setting. Go to step 7. 

b) Choose the option ‘This dataset is a subset of a hydraulic model dataset’ if 
you wish to associate the pipes selected with a particular ‘parent’ dataset which 
is a hydraulic model dataset (this is the default option). If you choose this 
option you will be prompted to choose a parent dataset using the combo box 
immediately adjacent. Go to step 6. 

 
The default option is shown in below:  
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Figure 26 Sector type selection 

 
5) If you are creating a Cluster dataset, you will see the dialog as shown below. You 

must tell CARE-W whether the pipe selection you have just made constitutes a 
subset of a hydraulically discrete area or not.  

 
 The option you choose here will determine whether you can inherit results 

from previous analysis conducted at sector or network level. 
 
a) Choose the option ‘This dataset does not belong to a hydraulic model 

dataset’ ONLY IF YOU ARE SURE the pipe selection is NOT hydraulically 
discrete. Go to step 7. 

b) Choose the option ‘This dataset is a subset of a hydraulic model dataset’ if 
you wish to associate the pipes selected with a particular ‘parent’ dataset which 
is a hydraulic model dataset (this is the default option). If you choose this 
option you will be prompted to choose a parent dataset using the combo box 
immediately adjacent. Go to step 6. 

 
The default option is shown in Figure 27. 

 

43 
 



Figure 27 Cluster type selection 

 
6) Inheriting hydraulic results and pipe attribute data from other datasets 
 
If you have chosen to create a sector or cluster dataset based on a subset of the pipes in 
a hydraulic model dataset, all existing pipe attribute data (excluding results data) from 
the parent dataset are made available automatically. The parent dataset is chosen by you 
as described in step 4(b) (sector dataset creation) or step 5(b) (cluster dataset creation).  
 
In addition, you may choose to inherit hydraulic results from the parent dataset, e.g. 
pipe pressures and HCI values from hydraulic criticality analysis. Results are stored in 
their own special type of dataset (known as a results dataset!) and if the user wishes to 
inherit these, he must choose which results dataset from which to inherit (se dialog box 
below). 
 
To do this, check the Inherit checkbox in the Relationship with a hydraulic dataset 
option group, then use the combo box which appears to select the relevant results 
dataset.  
 
 
N.B. The inheritance of results works only when a dataset is created. It is therefore 
advisable to conduct your hydraulic reliability analysis on the largest possible dataset 
which is relevant to your investigation FIRST. Clearly, this initial dataset should be 
hydraulically discrete and probably of type ‘network’. If this is done first, then any 
smaller datasets created subsequently will be able to inherit results from this initial 
dataset as described above.  
 
Go to step 7. 
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Figure 28 Inheriting hydraulic results 

 
7) Inheriting failure forecasting results 
 
In addition to pipe attribute data and hydraulic results, you may also wish to inherit 
failure forecasting results from a previous analysis on a larger dataset. All failure/burst 
rates and predicted failure/burst rates and their confidence intervals will be inherited 
from the results dataset you choose. 
 
To do this, you need to select the first option in the Relationship with a failure dataset 
option group, i.e. ‘This dataset is a subset of a failure dataset’ (se figure below). 
 

Figure 29 Inheriting failure forecasting results 
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Next check the Inherit checkbox, then use the combo box which appears to select the 
relevant results dataset from which you wish to inherit failure forecasting results. N.B. 
The inheritance of results works only when a dataset is created. It is therefore advisable 
to conduct your failure forecasting analysis on the largest possible dataset which is 
relevant to your investigation FIRST. If this is done first, then any smaller datasets 
created subsequently will be able to inherit results from this initial dataset as described 
above. 
 
Go to step 8. 
 
8) Finish dataset creation by clicking the OK button. The newly created dataset 

becomes the active dataset and the appropriate pipes are highlighted in purple. 
Alternatively, click Cancel to close the dialog without creating the new dataset. 

 
Dataset properties 
The Dataset properties form summarises the details of the active dataset, including 
name and description. It also includes a history of the analysis that has been carried out 
using this dataset, i.e. which tools have been run using the active dataset. 
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Figure 30 Dataset properties 

  

5.5 Dataset boundaries 
 
Dataset boundaries enrich the geospatial reporting of results, which are not specific to a 
particular pipe. An example of data to be displayed in this way includes performance 
indicator data applicable across all pipes in a network, sector or cluster dataset. Dataset 
boundaries may be created for network and sector datasets. Creating a dataset boundary 
creates a polygon with a particular boundary linestyle and fill pattern. Network and 
sector datasets will have identical boundary but different fill characteristics (except 
where fill colours are required to illustrate dataset results) and will be labelled with the 
appropriate dataset name. Dataset boundaries are created by using the Create Dataset 
Boundary  icon on the GIS toolbar. 
 
This button will prompt the user for a selection from a list of available datasets (Create 
New Dataset Boundary Dialog).  
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Figure 31 Dataset boundary dialog box 

  
The user may then draw a polygon around the zone in the usual way (single mouse click 
fixes vertex position; double click completes polygon). 
 

5.6 Analysis history 
This is available on the Dataset menu, under Dataset properties. This form is a useful 
reminder of the actions which have led to the current state of the active dataset. The 
dataset description may be changed at any time. The dataset name is, however, non-
editable. The results datasets produced using data from the active dataset are also shown 
in the top-right list box. 
 

Figure 32 Analysis history dialog box 
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5.7 Find and select facility 
CARE-W has the facility to find a selection of pipes with a give set of attributes. From 
CARE-W Toolbar click Expression builder . CARE-W finds objects residing in the 
active layer (GIS users) or simply the current [open] project (non-GIS users). (Note that 
a search on the All Pipes layer is equivalent to searching through the current [open] 
project.) Clicking the Find button on the GIS toolbar will display the standard dialog as 
shown below. This allows a range and combination of criteria to be applied to restrict 
the user’s search for objects.  
 

Figure 33 Expression builder dialog box 

 
The different buttons have the following meaning: 
 
Test 
Tests the criteria you entered in the Query syntax text box without selecting the pipes. 
Returns the number of records, which match the criterion/criteria you entered. 
 
Find 
Searches the project database and selects those elements, which match your search 
criteria. Highlights selection in GIS window in yellow. 
 
Update 
Allows data field to be updated using the Query syntax text box as an optional filter. 
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The Expression builder is a useful tool when working with CARE-W ARP and 
assessing values for the different criteria (using Update) for each pipe. From the 
CARE-W PI Tool there might exist results at a sector level (e.g. water quality or 
leakage data). These data can be used in the CARE-W ARP by using the Expression 
builder  > Update function. 
 
5.7.1 Selection using the GIS viewer 
CARE-W selects objects residing in the active layer. The active layer is the layer 
highlighted in the left-hand pane of the GIS viewer. The ‘All pipes’ layer is the default 
active layer. The GIS functions on the CARE-W GIS Toolbar provide a number of ways 
by which users can select objects (i.e. pipes or sectors) in the GIS viewer. The objects 
may be selected by point-clicking, or by drawing a variety of shapes around the desired 
object(s) to select them. 
 
The following drop-down lists allow the user to select the mechanism by which the 
drawn shape or line will select the underlying map objects. 
 

Figure 34 GIS asset 

 

6 WORKING WITH CARE-W TOOLS 
6.1 CARE-W interaction 
A main feature of the prototype software is the facility to interact with a pre-determined 
range of tools. CARE-W is not intended to bind together the external tools in a fixed 
and constraining way, but rather to allow the user to use them individually or in a 
sequence appropriate to the data available for analysis. 
 
Once the user has selected a tool to use for his analysis, data files need to be created 
which will allow the necessary data to be used by the tool. The CARE-W Prototype has 
a facility to create the import pre-existing input files for each of the CARE-W tools. 
CARE-W Prototype calculates values required by the PI Tool directly and automatically 
based on information in the central database.   
 
Analysis tool input files are created from data previously imported to the relevant 
CARE-W project database. An additional feature of the prototype is the facility to allow 
the user to view and edit the import files created by the prototype before the tools use 
them. This allows the user to check the integrity of their contents and to ensure 
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successful file creation. CARE-W uses Excel to facilitate data editing for the tools. If 
the input data files are edited interactively by a tool (e.g. CARE-W Fail or CARE-W 
REL), the edits are returned to the CARE-W database in addition to the results (output) 
data. 
 
For detailed help concerning the individual tools see each tools individual Help menu. 
In the CARE-W help system only a Brief Help for the tools is provided. 
 

6.2 Tools menu 
The different tools available in CARE-W are found via the CARE-W menu, under 
Tools. The tools are grouped according to their analysis function, namely: performance 
indication (CARE-W PI), failure prediction (CARE-W FAIL), hydraulic reliability 
(CARE- W REL), annual rehabilitation planning (CARE-W ARP), long term 
rehabilitation planning (CARE- W LTP) and others. The specific tools are listed under 
these generic items. The options for each of the tool sub-menus are consistent 
throughout. Generic functions include: 
 

• Accessing tool-specific help 
• Generating of input files from data in the project database (in order that the tool 

may be used to analyse the active dataset) 
• Running the tool 
• Importing the analysis results back into the central database 

 
The user may also view the input files that have been created by the prototype before 
the tool is run. The Edit Input Files menu item will open the specified input file, 
typically, as an Excel worksheet. The user can then view, edit and save the input file as 
they would a standard Excel workbook. 
 
If the ‘Help about’ option is the only menu item available for any tool, then CARE-W is 
unable to locate the tool. See Tool Manager (chap 4.6) for help detailing the application 
paths for the CARE-W tools. 
 

6.3 Using a tool 
Most interaction with the range of tools included in the CARE-W prototype is managed 
via the Tools menu. At the request of the user, the CARE-W prototype software will 
create the necessary input file(s) for an analysis tool from data held in the project 
database according to a pre-defined specification. These files may then be used to run 
the analysis tool within (or outside) the CARE-W framework. Similarly, the prototype 
will enable the results of the analysis to be exported back to CARE-W and stored as 
necessary on completion of the analysis task. 
 
The following procedure should be applied: 

• Import data 
• Select dataset 
• Generate input files for tool and edit as necessary 
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• Launch tool and conduct analysis 
• Return results to CARE-W database on completion of analysis 
• View results as required 

 
For running the different tools you need the necessary input data. The input data is 
imported to the CARE-W database via Project > Import>. Here you have the 
possibility either to import user GIS data, csv files or pre-existing tool input files.   
 
NB! Working with small samples 
When working with small datasets the user should pay special attention to the results 
from CARE-W Fail and CARE-W REL. The statistical models in CARE- Fail require a 
minimum sample in order to produce reliable result. The user might end up with models 
where no variables are significant. However, CARE-W forecast failures for each pipe. It 
is therefore essential to check the significance of the variables. It does not make sense to 
apply the pipe failure models on to small sectors. In order to succeed the models should 
be established based on pipes and failures in a larger sector (i.e. sample).  The minimum 
sample will depend on several factors such as: the number of pipes, the number of 
failures, the observation time, the number of variables, the number of modalities per 
variable etc.  As a rough estimate the users should not try to generate CARE- W FAIL 
models with less than 150- 200 pipes. The bigger the sample, the more reliable the 
results. Ideally, the user should try to have as many as 500 pipes before the analysis is 
carried out. 
 
For CARE-W REL models the results might also be misleading in cases where the 
hydraulic network is just a small part of the total network. What might look like an end-
pipe in a sub- model might for an expanded model for the whole city in reality act as a 
water main (with pressure reduction valve in to a new zone).  
 
However, CARE-W provides a facility to inherit hydraulic reliability results from a 
dataset which is known to be hydraulically discrete. This dataset may typically be a 
network dataset which is already modelled hydraulically and in CARE-W is called a 
‘hydraulic dataset’. When the user creates a dataset which is a sub-set of this hydraulic 
dataset, he has the option to inherit results from a previous analysis.  
 
A similar facility exists for the inheritance of failure forecasting results. 
 
See also Create new dataset dialog. 
 
Despite these facilities, it is wise to validate the results using appropriate engineering 
judgement.  
 

7 GETTING RESULTS 
7.1 Geospatial reporting 
Geospatial results are available both at sector level (e.g. leakage zones) and at pipe 
level. From CARE-W menu select Reports > GIS > Sector or Reports > GIS > Pipe 
to view results.  Below PIs for different zones are shown. This kind of map is useful 
when you want to focus on the areas where the problems occur.  
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Figure 35 Geospatial information 

  
See also Showing results using the GIS viewer (chap. 7.2). 
 
The GIS pipe view item will display the analysis results for each pipe (pipe ID) that 
correspond to results obtained from the asset-based analysis tools (CARE-W FAIL, 
CARE- W REL and CARE- W ARP), where these data exists. Where there are null 
values for some pipes, this might be due to a simulation error or mismatch between GIS 
data and hydraulic link data. More about this under Common difficulties and problem 
solving (chap. 3.3). 
 
The sector results (GIS display) will display results which are not specific to individual 
pipes. This would be results obtained from the CARE-W PI and CARE-W LTP 
modules. In order to report results at a sector level in GIS the user must manually assign 
boundaries to a dataset as described under dataset boundaries. 
  

7.2 Showing results using the GIS viewer 
There are two types of reports you can generate and view in the GIS viewer: those at 
dataset level and those at pipe level. The menu options for GIS reports are shown 
below. 
 

Figure 36 GIS viewer menu options 

 
Selecting Sector allows you to select a PI and display the results for that PI for all 
datasets visible (see figure below). The colour and bounds of the bands used to display 
the results may be modified by selecting the ‘Set bands and colours for PI’ menu item. 
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Figure 37 Selecting sector 

  
In a similar way, pipe-level results may be displayed by selecting the Pipe option, then 
‘Select pipe attribute…’. This time you will be prompted to choose a results dataset 
from which to display the results. If you have only created one results dataset from 
previous analysis of this dataset, CARE-W will select this results dataset automatically 
and confirm it has done so, e.g. 
 

Figure 38 CARE-W confirmation box 

 
You will then be prompted for the pipe attribute / result of interest, e.g. FR Poisson is 
the failure rate calculated by the Poisson tool (if you used it in your analysis), HR 
Relnet is the HCI calculated by Relnet (if used). 
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Figure 39 Select new pipe attribute dialog box  

  
If you click OK, the default bands will be used to display the results. As with dataset 
results, you may alter these from the Select pipe attribute dialog, or using the ‘Set bands 
and colours for pipe attribute’ menu item. An example output is shown below. 
 

Figure 40 Example of  output display in the GIS viewer 

 
NB!  
Results are displayed in a second [maximised] window. To return to the main GIS 
window, either minimize the results window or choose ‘Show GIS window’ from the 
CARE-W Window menu. 
 

7.3 Tabular reports 
Under the CARE-W menu, by clicking Reports the user will have access to different 
report templates. Results will be produced based on information held in the project 
database for the current (‘active’) dataset.  
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The tabular menu item allows the user to access non-GIS reports, detailing both project 
summary information and analysis results from individual CARE-W tools. The reports 
are created by querying data directly from the central database and exporting it to a 
spreadsheet application (currently MS Excel®.). The advantage of using these tabular 
reports is that a permanent record can be kept of the analysis undertaken and the results 
obtained by simply saving the spreadsheet with an appropriate name. All the tabular 
reports can be printed and saved by the user. The data within the reports can also be 
manipulated by the user and further analysis undertaken, if required. For the advanced 
user it is also possible to make user-defined reports in MS Access® (mdb query 
template). 
 
When the Tabular reports menu item is selected a dialog box will appear listing the 
reports that can be generated by the prototype. This list of reports is shown under the 
CARE-W menu. The reports are discussed in turn in the following sections. 
 
7.3.1 Strategic Planning – global budget report 
This report will summarise results from the CARE-W LTP (KANEW). The aim of this 
report is to present the strategic budget value (in Euro) and the rehabilitation strategy 
that has been specified to develop this budget. The following information could 
therefore be displayed in this report: 
 

• Ageing parameters specified for each type of asset (pipe, valve, etc.) within the 
dataset; 

• The rehabilitation scenario selected by the user; 
• The rate of rehabilitation and forecast failure rate as a result of the 

rehabilitation work, and; 
• The global budgets developed by the rehabilitation strategy manager over the 

specified planning horizon. 
 
A rehabilitation scenario would show the asset type(s) and length(s) to be rehabilitated 
in a given period and the replacement material. For example 40 km of cast iron main 
should be entirely replaced by polyethylene pipe between 2002 and 2003. 
 
The global rehabilitation budget would be displayed as a total spend for the period of 
rehabilitation, as an annual spend or as a spend over a given period, e.g. annually for the 
first 5 years then the total for each subsequent 5 year period. 
 
The rehabilitation strategy manager tool can display a wide range of analysis results, 
such as a breakdown of the expected residual service life for each asset type, based on 
the specified rehabilitation scenario. These results can be printed as charts or exported 
as text files. It is therefore not proposed that the prototype reproduce such reports, but 
will instead produce a summary of the information required by the user as specified in 
the CARE-W procedure. 
 
7.3.2 Project summary – current performance report 
This report summarises the calculated performance indicators for a given CARE-W 
project. The PI’s are listed for each dataset within the project, where the PI tool has 
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calculated these values. A worksheet report for each analysis period will be produced, 
allowing a complete summary of all the PI analysis that have been undertaken for a 
given project. This report has the same function as the Sector results (GIS display) 
menu item, but the PIs would be listed against each dataset rather than displayed as 
coloured GIS polygons, and can be permanently recorded by saving the report file. 
The spreadsheet format report will also allow the user to plot the PI values and directly 
compare the performance of the datasets within a given project.  
 
7.3.3 Dataset summary  
This is a straightforward report, which summarises the current status of the active 
dataset, i.e. before any rehabilitation plan is implemented. This report would contain the 
following information: 
 

• Category of asset, grouped by material and diameter 
• The length of each category of asset 
• The average age of the pipes in each category of asset 

 
7.3.4 Dataset failure forecasting results 
This report summarise asset-based results from the failure forecasting tools, CARE-W 
FAIL. The report allows the user to have a permanent record of the analysis results that 
have been obtained. The report lists the analysis results for each pipe within the active 
dataset, displaying the user reference, material, diameter and length. 
 
7.3.5 Dataset hydraulic reliability results  
This report summarise asset-based results from the hydraulic reliability modelling tools, 
CARE-W REL. The report allows the user to have a permanent record of the analysis 
results that have been obtained. The report lists the analysis results for each pipe within 
the active dataset, displaying the pipe ID, material, diameter and length. 
 
7.3.6 Dataset PI report 
This report will summarise the calculated PI values (CARE-W PI) for the active dataset. 
This report will list the performance indicators that have been selected within the PI 
tool, together with the code and units that apply to each. The PIs values will be 
displayed for the period over which they were calculated.  
 
7.3.7 Dataset pipe rehabilitation plan 
This report presents the analysis results from CARE-W ARP module. The calculated 
values for each criterion from the desired points of view selected by the user will be 
listed for each pipe in the active dataset. The report will also indicate whether an 
individual pipe has been classed as a hotspot for a particular criterion. The pipe status 
table (MCD Status versus pipe ID) will be at the top of the report, followed by values 
for the selected points of view criteria in turn, underneath. 
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8 USING YOUR RESULTS 
8.1 What do they mean? 
The CARE-W Toolkit can be used in many different ways, depending on the users’ 
needs and the data availability. There are many potential routes through the software. 
The typical results for the tools are shown in chap. 1.3-1.7 (i.e. CARE-W PI, CARE- W 
FAIL, CARE-W REL, CARE-W ARP, CARE-W LTP). Based on this the user should 
be able to identify his/her needs with respect to which tools to apply. Detailed 
information about the output for the different tools is found in the tool specific help or 
in the Brief help session (Appendix). In the following we will give additional 
information about the integrated use of the tools and how to interpret the results. 
 

CARE-W PI

PI Tool - Water Losses (zones)
- Complaints / W. Quality
- etc.

- Hydraulic Criticality 

- Predicted Failure Rate
- Predicted Burst Rate

- Number of People Supplied
- Sensitivity of the Road
- etc.CARE-W FAIL

CARE-W PHM

CARE-W Poisson

CARE-W REL

F-Reliab

AQUAREL

RELNET

URBAN DATABASES

CARE-W ARP

Figure 41 Integrated use of the results in CARE-W for generating annual rehabilitation plans 

 
CARE-W PI is a powerful diagnoses and decision support tool. It might also serve the 
CARE-W ARP module with information for generating the annual rehabilitation plan.  
 
For CARE-W Fail there are two alternative models, CARE-W PHM and CARE-W 
Poisson for calculating the failure rate for each pipe. The failure rate (FR) for each pipe 
is a major parameter to calculate CARE-W ARP criteria. The statistical analysis is the 
CARE-W Fail tools also provides useful information about the behaviour of your 
system and which factors influencing the failure history of the network.   
 
In CARE-W there are three alternative reliability models (i.e. Aquarel, F-Reliab, and 
Relnet). The models calculate a hydraulic criticality index (HCI), expressing the 
hydraulic impact/consequences due to a pipe failure in the network. The HCI is one of 
the possible criteria to be used in CARE-W ARP. Since the different models have 
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different approaches the absolute values can not be compared. The tools Aquarel and F-
Reliab include failure data in the calculations and Relnet does not. Nevertheless, the 
relative ranking of the critical pipes are normally similar. The user should use the model 
he is most familiar with.   
 
Special attention should be made for CARE-W ARP and the ranking procedure. Based 
on different criteria (impacts) the pipes are ranked in six (6) categories (e.g. C33, C32, 
C31, C22, C21 and C11). The most likely candidates for rehabilitation are in category 
C33, then follows C32, C31, C22 and so on.  
 

Figure 42 Outranking procedure in CARE-W ARP 

 
The values for the weights and thresholds in CARE-W ARP influence the distribution 
of pipes in the categories and can be used as “adjusting screws”. Some guidance for 
choosing the right values is given in the tool specific help of CARE-W ARP. Further 
details are available in the official CARE-W reports D7 “Survey of multi-criteria 
techniques and selection of relevant procedures”. 
 
The costing tool pick up results from the CARE-W ARP and for each candidate for 
rehabilitation (e.g. pipes) the recommended rehab technique, cost, and time for 
rehabilitation is given.  
 

8.2 Supplying inputs for the rehabilitation plan 
Results from CARE-W can be used as input for rehabilitation planning in many ways. 
The individual tools supply with useful information for really understanding the 
network. The CARE-W ARP provides support to rank potential rehabilitation  projects 
to be included in the rehabilitation plan for the water utility. 
 

59 
 



8.3 CARE-W and Common Framework for Capital Maintenance Planning 
(UK) 

The focus for future mains rehabilitation in the UK will be through the Common 
Framework for Capital Maintenance Planning. It is important to consider how CARE-W 
and the Common Framework align. The Common Framework is founded on risk-based 
principles so that in most cases capital maintenance will be justified on the current and 
future probability of asset failure and the resultant consequences for customers, the 
environment and water service providers, including the costs arising. Element from the 
Common Framework can also be useful to apply elsewhere. 
 
It is considered that the CARE-W tools map onto the key steps in the Common 
Framework and go further in terms of providing decision support for rehabilitation 
implementation. The tools not only define broad budgetary needs but also identify the 
pipes that are most in need of rehabilitation. Furthermore, the long-term rehabilitation 
tools provide a basis for strategic failure forecasting and cost modelling for a variety of 
generic rehabilitation options.  This is shown below in Table 1. 
  
Table 9 How CARE-W addresses the key stages in the Common Framework  
Framework Stage Framework element CARE-W tool/process 
Historical analysis A1 Expenditure review 
 A2 Performance review 
Forward-looking 
analysis 

B1.1 Focus analysis 

Performance indicator tool:  
Trends and comparison of PIs and 
benchmarking with standard performance 
databases 

-preparation B1.2 Planning objective Selection based on end user preference 
 B1.3 Monitor failures PI tool and Rehab. Manager GIS 
 B1.4 Customer survey End user liaison 
-service/cost forecast B2.1 Failure modes Failure modes already identified by 

CARE-W consortium 
 B2.2 Observations End user databases and GIS, which 

populate Rehab. Manager  
 B2.3 Methods for:  
 - failure probability PHM and Poisson tools, long term 

planning tools, reliability tools 
 - consequence ARP, REL, Scenario writer 
 - cost Rehabilitation Strategy Manager, 

Rehabilitation Scheme Developer: 
These tools estimate costs at the strategic 
level and for annual planning 

 B2.4 Validate methods End user testing and practical application 
 B2.5 Forecast service PHM and Poisson tools, long term 

planning tools, reliability tools 
-intervention analysis B3.1 Identify options CARE-W team knowledge base 
 B3.2 Estimate impact 
 B3.3 Estimate costs 
 B3.4 Value changes 
 B3.5 Select optimum 
 B3.6 Categorise costs 

Rehabilitation Strategy Manager, 
Rehabilitation Scheme Developer, ARP 
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8.4 What now? 
It is not the intention of CARE-W that the central CARE-W database should replace the 
users own database system. An efficient way of working with CARE-W is to import 
data from the local database, run CARE-W with all or some of the tools and afterwards 
export relevant results back to the user’s local database. Example of useful information 
to export back might be: 
 
Pipe level: • Failure rate (CARE-W Fail) 
 • Break rate (CARE-W Fail) 
 • Hydraulic criticality index (CARE-W 

REL) 
 • Priority level (CARE-W ARP) 
 • Hotspots (for criteria in ARP).  
  
Cluster/sector/network level: • PI results (CARE-W PI) 
 • Long-term rehab needs/strategy (CARE-

W LTP)  
 

In this the information provided by CARE-W serves as a basis for infrastructure data 
management.  
 
This completes the guide for CARE-W. The best way to learn about it is to play with 
CARE- W and the tools. 
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APPENDIX: BRIEF HELP FOR THE TOOLS 

Brief help for the tools- general 
 
The different tools have their own help facility available from the CARE-W menu, 
under Tools > "Toolname" > Help About. Nevertheless, in the appendix a brief help 
for the following tools a provided: 
 
Aquarel brief help, Relnet brief help, F-Reliab help, Poisson help, PI Tool brief help, 
Rehab scenario writer, Rehabilitation strategy manager, Rehab Programme Evaluator 
and ARP Brief help. 
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Brief help PI Tool 
 

Tool version number: 1.0 
Help file version number: 0.2.0 
Author(s): LNEC 
Date: 19th June 2003 
 

General description 
The PI Tool is a computer program that makes available to the CARE-W water supply 
network rehabilitation procedure an information system for the calculation, storage, 
update and retrieval of performance indicators and their associated information. Apart 
from the values of indicators and their calculation data, the system provides complete 
information on all their features, properties and relationships. The PI Tool makes use of 
the common CARE-W database standard. 
 
The PI Tool is published either as a stand-alone program or as an integrated facility 
within the CARE-W software package. 
 
A performance indicator (PI) is a quantitative measure of a particular aspect of the 
undertaking’s performance or standard of service. It assists in the monitoring and 
evaluation of the efficiency and effectiveness of the undertaking, thus simplifying and 
reducing to a comparable basis an otherwise complex evaluation. 
 
Scope of application 
In the CARE-W water supply network rehabilitation procedure, a system of PI has been 
developed specifically for pipe network rehabilitation. The system is inspired on the 
International Water Association (IWA) performance indicators system for water supply 
services and is described in full detail in CARE-W Report 1.2 (Baptista & Alegra, 
2002). It is divided into five sections: water resources indicators, physical indicators, 
operational indicators, quality of service indicators and financial indicators. 
Additionally to this set of PI, there is a number of Additional Performance Measures 
(APM), which are deemed to be useful for the CARE-W project. APM are ratios 
between values of identical or different nature, equally expressing the performance of 
the undertaking regarding a given point of view, but more difficult to assess. 
 
Data  
 
Pre-processing 
The assessment and interpretation of rehabilitation PI require specific information, 
which is in itself an important part of the CARE-W PI system. The input data for the 
CARE-W PI system can be generated by the undertaking, in the shape of Utility 
Information (UI), or externally to it , as External Information (EI). 
UI is the set of data that is directly related to the activity of the utility (organisation and 
its physical system) and is under its direct control. It is used either for the assessment of 
the selected PI (as PI input variables) or for the CARE-W decision making process. UI 
are grouped into six sections: physical assets data, water volume data, operational data, 
technological resources, quality of service data and financial data. 
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EI is the set of data that cannot be directly influenced by the utility – i.e., it translates 
features that are external to the organisation and to its physical system - but that is 
critical for establishing the rehab diagnosis or for support to the CARE-W decision-
making process (e.g. rain fall, temperature, ground slope, type of soil, etc.). it essentially 
corresponds to the ‘Context information / Region profile’ group of the IWA-PI system. 
 
Minimum input data requirements 
The CARE-W rehabilitation PI system includes 49 performance indicators. The system 
is complete with the corresponding 154 UIs and 29 EIs. 
 
Data input in the PI Tool means typing in EI and UI values through specific tabular 
forms. EI helps to provide a context for the PI analysis, but are not used when 
calculating PI. The user may input EI values to the PI database at any moment during a 
session, provided a dataset and analysis period have been selected. 
 
For a set of PI to be calculated, the database must contain values for the necessary UIs. 
The number of PI that are calculated in any session will therefore depend on the amount 
of UI data that has been provided. 
 
All the UI data and PI are defined in the PI/UI Manager menu option. When each UI is 
selected its definition is given, together with the units and the PI it is used to calculate. 
Additional input data options 
 
The data input procedure described in Section 3.2 is for the stand-alone application of 
the PI Tool. When the PI Tool is used within the framework of the CARE-W prototype 
then additional data input facilities are available. Full details of these facilities can be 
found in the Prototype Help, however they are outlined below. 
 
Where specific information about the pipes in a dataset is already stored in the CARE-
W database, this information can be automatically loaded in to the PI database. This 
data would mainly be the physical attributes of the dataset such as the total length of 
pipes of different materials, the age of the pipes, the amount of rehabilitation that has 
been undertaken or the number of bursts. If the user chooses to use this facility, the 
available UI and EI data will be displayed in the UI and EI input forms. The data will be 
specific to the analysis period selected by the user. 
 
This data can be edited by the user at any time. 
 
Where a PI analysis has been carried out for dataset for a particular analysis period, then 
the UI and EI data can be inherited. In this situation the prototype searches the PI 
database for the historical analysis period with end date closest to the start date of the 
new analysis period. Where more that one historical period has the same end date, then 
the analysis period with the closest start date is selected. 
 
Output data 
In the current release of the PI Tool, the user is given several ways to output the results 
of a PI Tool session; saving to the database, exporting to an MS Excel File , or printing 
to a formatted report form. 
Strengths 
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The systematic assessment and use of performance indicators is a widely disseminated 
practice in many industrial sectors. Any modern productive industry strives to maximise 
internal efficiency in order to improve profits, and monitors its customers’ views and 
attitudes, with regard to the services provided, in order to adapt them to the customers’ 
preferences. PI are an essential tool for those purposes and have for a long time been a 
central part of management procedures. 
 
The PI selected in the framework of the CARE-W project comply with the following 
requirements: 
 
i) represent all the relevant mains rehabilitation aspects of a water undertaking’s 

performance, allowing for a global representation of the system by a reduced 
number of performance indicators; 

ii) suitable for representing those aspects in a true and unbiased way; 

iii) be clearly defined, with a concise meaning and a unique interpretation for each 
indicator; 

iv) include only non-overlapping performance indicators; 

v) be ratios between values of identical or different nature; 

vi) require only measuring equipment that is affordable, the need for sophisticated and 
expensive equipment being avoided; 

vii) be auditable, which is specially important when the performance indicators are to 
be used by regulatory bodies that may need to check the results reported; 

viii) be easy to understand, even by non-specialists e.g. consumers, wherever possible; 

ix) refer to a well-defined period of time; 

x) refer to well-defined geographical areas; 

xi) be applicable to undertakings with different characteristics and stages of 
development; 

xii) be as few as possible, avoiding the inclusion of non-essential aspects. 

 

Limitations 

The stand-alone version of the PI tool relies upon the manual input of UI and EI data by 
the user, for each dataset and analysis period. This activity has been simplified by the 
addition of a facility to allow the import of data in the form of an excel spreadsheet. The 
Auto-load facility of the prototype also reduces the amount of duplicated effort required 
by the user. 
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How-to guide 
 Step 1 Select a well defined geographical area using the GIS viewer 

facility of the prototype. This active dataset will be analysed 
using the PI Tool. 

 Step 2 From the prototype tools menu select the PI tool. The user will 
then have the option to select an existing analysis period, define 
a new period or run the PI tool in stand-alone mode. The first 
two options will enable the auto-load of pipe attribute data that 
already existing for the active dataset. 

 Step 3 Once the relevant auto-load has been completed, select run ‘PI 
tool’ from the PI Tool menu option. 

 Step 4 When running the PI Tool within the CARE-W environment, 
the relevant PI database will automatically be opened. Each 
CARE-W project database will have an associated PI database. 

 Step 5 Inside the PI tool select ‘Open Dataset’ option from the ‘Tools’ 
menu. Select the dataset to be analysed and define the period of 
assessment. 

 Step 6 Select the ‘PI/UI Manager’ from the ‘tools’ menu. 

 Step 7 Using the tick boxes, select the PI to be analysed. Click OK to 
exit and save information. 

 Step 8 Enter data in the EI and UI forms. These forms can be accessed 
from either the ‘Tools’ menu or through the ‘EI input’ and ‘UI 
input’ icons. 

 Step 9 Once the EI and UI data has been stored to the PI database, 
select ‘Calculate’ from the ‘Tools’ menu or use the ‘Calculate’ 
icon. 

 Step 10 The number of PI that have been calculated will be displayed. 
When this window is closed the PI report will be displayed. The 
PI results can then be saved directly to the PI database. 

 Step 11 The PI results can be displayed graphically within the PI Tool. 
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 Brief help CARE-W_FAIL_Poisson  
Tool version number: 1.03 
Help file version number: 1.01 
Author: INSA Lyon, France 
Date: 23 January 2003. Revised: 10 February 2003.  
 

 
General description 
Care-W_FAIL_Poisson assists end-users to define pipe categories and to calculate the 
failure or burst rate of each category. The method depends upon whether additional 
statistical software is available to conduct the regression analysis, i.e.: 

• Where statistical software (e.g. Stata) is available the user may: 
o (Re-)define pipe categories (using results of c) 
o Prepare and export data  
o Conduct statistical analysis (Poisson Regression Analysis) 
o Generate a failure rate for each pipe category 

• Without statistical software: 
o pipe categories defined a priori 
o descriptive statistics available 
o Failure rate / pipe category and failure rate / pipe generated 

 
Scope of application 
For short historical records and/or for short pipes, previous failures/bursts are very 
scarce.  
 
Data 
 
Pre-processing 
The user is required to modify and validate (and possibly also create) the input text files, 
City_sdf.txt and City_mdf.txt. See section 3.3 for input formats and data description. 
 
Minimum input data requirements 
City_sdf.txt: 

I1 ID User reference (Pipe Id) 
C1 L Length (m) 
C4 Inst Date of installation  

 
City_mdf.txt: 

ID User reference (Pipe Id) 
FailureDate Date of failure 
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Optimal input data 
Segment descriptive data: City_sdf.txt    
   Mandatory or

Optional 
Quantitative or 
Qualitative or 
Both possible 

Data type 
accepted 

Unit Description 

I1 ID or 
ID1, 
ID2,  

…, IDn 

Mandatory Qualitative Alphanumeric  Variable or set of n variables that 
uniquely identifies the segment 
(one and only one per segment) 

I2 STR Optional Qualitative Alphanumeric  street, road or locality 

Se
gm

en
t I

de
nt

ifi
ca

tio
n 

I3 AREA Optional Qualitative Alphanumeric  area (municipality or region or 
zone) 

C1 LENG Mandatory Quantitative Number (Single 
precision) 

m Segment length 

C2 DIAM Mandatory Quantitative Number (Single 
precision) 

mm Segment diameter 

C3 MAT Mandatory Qualitative Alphanumeric  Segment material  

C4 INST Mandatory Quantitative Date DD/MM/YYYY or 
MM/YYYY or 
YYYY 

Date of installation 

C5 REPL Optional Quantitative Date Year (YYYY) Date of replacement of the 
segment 

Se
gm

en
t c

ha
ra

ct
er

is
tic

s 

C6 REHA Optional Quantitative Date Year (YYYY) Date of rehabilitation of the 
segment 

C7 IPRO Optional Qualitative Alphanumeric  Internal protection 

C8 EPRO Optional Qualitative Alphanumeric  External protection 

C9 JOIN Optional Qualitative Alphanumeric  Type of joint 

 

C10 DEPT Optional Quantitative Number (Single 
precision) 

m Depth 

 
 
 
SDF table (continued) 

E1 SOIL Optional Both Alphanumeric mΩ Type of soil (or soil resistance) 

E2 TRAF Optional Both Alphanumeric Number of 
vehicles/time or 
class of traffic 
intensity 

Traffic in the street or road 

E3 LOCA Optional Qualitative Alphanumeric  Location of the segment in the 
street (under sidewalk or 
pavement) 

E4 BEDD Optional Qualitative Alphanumeric  Type of bedding 

E5 PRES Optional Quantitative  MPa Pressure in the segment (static 
max. or dynamic min. or max. 
difference between static and 
dynamic) 

E6 NBSC Optional Quantitative Number (Integer) <Number> Number of Service Connections 

E7 ...      

E8 ...      

Se
gm

en
t e

nv
iro

nm
en

t 

E9 ...      
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Maintenance data: City_mdf.txt 
  Mandatory or

Optional 
Quantitative or 
Qualitative or 
Both possible 

Data type 
accepted 

Unit Description 

M1 ID Mandatory Qualitative Alphanumeric  Number or variable that identifies the segment 
(one and only one per segment) 

M2 FDAT Mandatory Quantitative Date DD/MM/YYYY or 
MM/YYYY or 
YYYY 

date of failure 

M3 FTYP Optional Qualitative Alphanumeric  Type of failure 
M4 FCAU Optional Qualitative Alphanumeric  Cause of the failure 
M5 RTYP Optional Qualitative Alphanumeric  Type of repair 
M6 …      

 
Output data 
City_Poisson_FR.txt 

First line: 
Pipe Id; FR; 1995;2000; done by KL … 

with : 
pipe id : UserReference (pipe id) 
FR : Failure rate (observed over the chosen period or calculated by Poisson over the chosen 
period) (No/km/yr) 
« 1995 », « 2000 »  chosen period for the calculation of the rate  
« done by …. » : free comment  

 

For each pipe: 
- User Reference (Pipe Id) 
- FR (No./km/yr) = Max[FR(i), FR(j)] where FR(i) is the failure rate of the 
individual pipe i, and FR(j) is the failure rate of the corresponding category. 

 
City_Poisson_BR.txt 

First line: 
Pipe Id; BR; 1995;2000; done by KL … 

with : 
pipe id : UserReference (pipe id) 
BR : Burst rate (observed over the chosen period or calculated by Poisson over the chosen 
period) (No/km/yr) 
« 1995 », « 2000 »  chosen period for the calculation of the rate  
« done by …. » : free comment  

 

For each pipe: 
- User Reference (Pipe Id) 
- BR (No./km/yr) = Max[BR(i), BR(j)] where BR(i) is the burst rate of the 
individual pipe i, and BR(j) is the burst rate of the corresponding category. 

 
Strengths 
a) For datasets corresponding to a short history (e.g. 5 years) and/or for small-length 
pipes (e.g. 50m) the number of previous failures that have been recorded is null for a 
large part of the pipe set. 
Using pipe categories allows to deal with this aspect. 
 
b) Using the Poisson Regression Analysis can consolidate definition of homogeneous 
pipe categories. This analysis allows to separate significant and non-significant failure 
factors. 
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Limitations 
Care-W_FAIL_Poisson allows to calculate failure/burst rates and to prepare data for a 
Poisson Regression Analysis. In this version, the Regression Analysis has to be done 
with statistical software (e.g. STATA) using the file: city_Poisson_Reg_Data.txt. 
 
How to guide 

 Step 1 Import data: City_sdf.txt & City_mdf.txt 

 Step 2 (Re-)define Categories : Choose explanatory variables and associated 
‘modalities’ 

 Step 3 [Cluster categories to create new ones]  
Not available in Poisson 1.x 

 Step 4 Choose data concerning  
                 All failures in your dataset               and/or 
                 Some failures in your dataset         and/or 
                 Bursts in your dataset                      

 Step 5 Choose a period of observation  

 Step 6 Generate output files  
                 City_Poisson_ FR.txt               and/or 
                 City_Poisson_ BR.txt               and/or  
                 City_Poisson_Reg_Data.txt              

 (Step 7) 
optionnal

Poisson regression analysis  feed back results to step 2 if necessary 
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Brief help Aquarel  
Tool version number: 0.2.2 
Help file version number: 0.2 
Author: SINTEF, Department of Water and Waste Water, Norway 
Date: 19 December 2002. Revised 7 February 2003. 
 
 
General description 
AQUAREL calculates reliability measures for the hydraulic reliability of a water 
distribution network allowing simultaneous failure of equipment. The approach is based 
on hydraulic simulations of the conditions in the network (i.e. EPANET 2.0.10) 
combined with standard reliability calculation techniques. The idea is to close the links 
in the network and examine the effect on the supply nodes using EPANET. The model 
also takes into account the volume-effect of the tanks. Aquarel calculates several 
reliability measures. Within the scope of CARE-W, AQUAREL can be used for 
defining candidates for rehabilitation based on the importance of each pipe (i.e. the 
hydraulic criticality index, HCI).  
 
As input data, AQUAREL requires the failure intensity (“failure rate”) for all links (i.e. 
pipes and pumps) in the network. AQUAREL calculates several reliability measures at 
pipe (i.e. node) level (i.e water supply availability, frequency of degraded pressure, link 
importance_ B, link importance_ U and link importance_ F).  
 
We recommend you download Epanet 2.0 for Windows to create and test input files 
prior to running under RelNet. 
 
See: 
http://www.epa.gov/ORD/NRMRL/wswrd/epanet.html
 
 
Scope of application 
Aquarel calculates reliability measures for nodes and pipes in the network. For CARE-
W only the reliability measure Hydraulic criticality index (HCI) for pipes are used. 
However the following measures are calculated and available via the Aquarel result file.  

• Water supply availability 
• Frequency of degraded pressure 
• Hydraulic criticality index (HCI) (the only data exported to the Prototype) 
• Importance_ B 
• Importance_ U 
• Importance_ F  

 
Data  
 
Pre-processing 
AQUAREL requires an EPANET input file (*.inp) for the reliability calculations. In 
order to avoid internal EPANET error messages the *inp file can be run separately in 
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Epanet to check for error messages. Input files which are able to run in Epanet are also 
able to run in Aquarel.  
 
AQUAREL also requires reliability data for each link (i.e. pipes and pumps) in the 
network. The data format for the reliability data is a Microsoft Access database (*.mdb). 
The number of pipes and pumps in the reliability input data file should correspond to 
the number of pipes and pumps in the Epanet input file.  
Minimum input data requirements 
The AQUAREL procedure requires the following input data: 
 
Pipe_ID Unique identifier for each pipe  
Availability Proportion of time the link is functioning 
Frequency Frequency of failures (1 / MMTF) 
MTTR Mean time to repair 
TTR_99 99 % percentile of the time to repair 
Hydraulic model An EPANET-compatible hydraulic model is required (*.inp) 
 
AQUAREL also requires reliability data for each link (i.e. pipes and pumps) in the 
network. The data format for the reliability data is a Microsoft Access database (*.mdb). 
(present version is Office 2000). 
 
  Format for input reliability data for pipes (table: tbllinks) 

I Availability Frequency MTT 99 % percentile 
1 0.9900000095367 9.99999977648258E- 5 15
… … … … …
 
Format for input reliability data for pumps (table: tblpumps) 

I Availability Frequency MTT 99 % percentile 
9 0.9900000095367 9.99999977648258E- 10 30
… … … … …
 
For pumps the data in the table tblpumps shown above can be used as default values if 
the user does not have his/her own data. 
 
For pipes the following process can be applied: 
 
1. Default values MTTR/TTR99: 

 Repair time (hours) 

Pipe diameter 
(mm) 

MTTR TTR99 

< 300 8 24 

300 - 400 16 48 

> 400 24 72 

 
2. Frequency: 
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The frequency can be estimated based on results from the failure forecasting models 
(CARE-W FAIL). For example, the output from the PHM model (PHM_Output.txt) 
calculates FN: Mean number of forecasted failures (or breaks) within the time horizon. 
If the forecast is made for one year this value is equivalent to the MTTF. Taking the 
inverse of this value gives the frequency. If no result from CARE-W FAIl is available, 
rough estimates can be calculated based on maintenance data (e.g. by group of pipes).  
 
3. Availability 

Calculated availability based on A= MTTF/(MTTF+MTTR), where MTTF is the 
inverse of the Frequency (1/Frequency). All units should be in [years]!  
 
Optional input data  
Within Aquarel software the user can decide upon the following items: 

• Critical pressure 
• Simulation for specific node (if only interested in the results of one node) 
• Including double failures (up to two failures can happen simultaneously) 
• Choose criteria for dynamic simulations (seldom in use) 

 
Output data 
AQUAREL reports the results as a text file (*.aqr), where the default name is the same 
as the name of the Epanet input file. The AQUAREL output file is split into sections. 
The only section containing data for the prototype is the one named 
[LINK_CRITICALITY] and HCI (Hydraulic Criticality Index). This field is used in the 
multi criteria decision in the Prototype as one criteria for ranking pipes for 
rehabilitation.  
 
As mentioned in under Scope of application, AQUAREL also calculates other reliability 
measures. These are of special interest in a more comprehensive vulnerability analysis 
of a water network. 
 
Strengths 
Using a hydraulic reliability model (eg. Aquarel, Relnet or Failnet- Rel) presents the 
user of the Prototype with valuable information compared to running a standard 
hydraulic simulation (e.g. Epanet). All the three hydraulic reliability models included in 
the prototype reports more or less the same results. However, since each model has a 
unique approach, the values for the different reliability measures may not be 
comparable.   
 
Limitations 
In vulnerability analysis it might be of interest to analyse what happens if more than one 
(or two) pipes or pumps is in a failure mode. These situations are not handled by the 
reliability tools.  
 
Before applying the results the user should visually check whether the reported results 
make sense.  
 
How-to guide 
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 Step 1 Define/calculate reliability data for each link in the network (i.e. 
pipes and pumps) in a Microsoft Access database (*.mdb) 

♦ Reliability input data for pipes are stored in a table called 
tbllinks 

♦ Reliability input data for pumps are stored in a table called 
tblpumps 

 Step 2 Define an Epanet file (*.inp) which describes the network. The 
filename must be the same as the *.mdb file. Input files which 
are able to run in Epanet are also able to run in Aquarel. 

 Step 3 In the Aquarel user-interface choose the Epanet file (*.inp) and 
the name of the output file. Decide upon: 

♦ the critical water pressure 

♦ whether or not to include double failures  

 Step 4 Run Aquarel  

 Step 5 The result for each pipe is exported to the Prototype (i.e. 
hydraulic criticality index, HCI). The complete AQUAREL 
results are given in the results folder or in the text file *.aqr.  
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 Brief help Relnet 
Tool version number: 2.01 
Help file version number: 1.02 
Author: Institute of Municipal Water Management, Brno University of Technology, 
Czech Republic. 
Date: 23 January 2003. Revised 7 Jan 2004. 
 
 
General description 
RelNet calculates the impact of each pipe link on the total network reliability. 
RelNet is based on the Epanet computing core and requires an Epanet data file (*.inp) 
available using Epanet’s own Export Network function. 
 
The result value is HCI (Hydraulic Critical Index) for each pipe - the impact of each 
link on the total network reliability. 
 
Scope of application 
RelNet is a stand-alone Win32 application running under Win 9x,NT,W2k and XP and 
has been successfully tested on all platforms. RelNet is programmed in Borland Delphi 
7 under Win XP. RelNet requires an Epanet computation core (epanet2.dll) distributed 
with RelNet. 
 
We recommend you to download Epanet 2.0 for Windows to create and test input files 
prior to running under RelNet. 
 
See: 
http://www.epa.gov/ORD/NRMRL/wswrd/epanet.html
 
Relnet comes complete with the following items: 

• RelNet.Exe - the application 
• Relnet.hlp - help file 
• epanet2.dll - dynamic linked library 
• test.inp - sample network 

 
Method 
For each node in the network: 
 

• Actual head pressure and demand are calculated for the network in its original 
state. None of the pipe links is discarded. The results are Q_act (actual demand), 
H_act (actual pressure) and sum of Q (Q_total). 

• One pipe link is discarded. The network pressure analysis and calculation 
of pressure in each node (H_new) and calculation of demand (Q) is realized.  

 
Calculation of HCI: 

 The hydraulic criticality of the discarded link is calculated from the volume of 
undelivered water in the entire network. The amount of undelivered water in each 
node depends on the calculated pressure value (H_new).  
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 if H_new < H_min, then Q_new = 0. If the H_new value is lower than 
H_min we assume that the consumer demand is not satisfied and the amount 
of delivered water is 0 in this node. 

 if H_min* < H_new < H_req** , then the amount of delivered water in the 
node is reduced and is calculated according to the following formula:  

H_act
H_new

 Q_act  Q_new ⋅=  

* Minimum recommended value of H_min (pressure head in metres) is 15. 
**Minimum recommended value of H_req (pressure head in metres) is 25. 

 if H_new > H_req, then the consumer demand is fully satisfied and delivered 
water Q_new = Q_act (nothing has changed).  

 Delivered water Q_new is calculated by this method for each node of the network.  

 The total sum of Q_new is calculated over all nodes of the entire network. Then HCI 
is calculated according to the following formula: 

( )
Q_total

Q_newQ_total
  HCI ∑−

=  

 
Higher value of HCI means higher impact of the discarded link on the total network 
reliability.  
 
If the Σ(Q_new) = 0 then demand is not satisfied in all nodes of the network and 
HCI = 1. 
 
If Σ(Q_new) = Q_total, HCI = 0 and the demand is fully satisfied at the required 
pressure. 
 
Data  
 
Pre-processing 
Hydraulic models should be created, tested and validated in Epanet before using with 
Relnet. 
 
Minimum input data requirements 
An operational Epanet network exported as an *.inp file. 
 
Optional input data  
None stated. 
 
Output data 
The output text file and MS Excel file contain values in the following order: 
 
LinkID; RemovedNodes; Nodes<RP; HCI 
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LinkID – identification of discarded link 
RemovedNodes – number of discarded nodes during the "Link processing". This value 
presents the number of disconnected (not supplied) nodes, if a particular link is 
discarded. 
Nodes<RP - this value presents the number of nodes that have lower pressure than the 
required pressure (the value given from the “HCI Processing” stage) 
HCI (Hydraulic Critical Index) – the impact of the jth pipe link on the total network 
reliability. The range is <0,1>. If the pressure of all nodes is higher than required 
pressure (RP) and none of the nodes was disconnected, the value is equal to 0.  
 
After processing you can open the results file using MS Excel. This allows sorting and 
other useful manipulation. All this information is also displayed in a grid in the main 
RelNet window. 
 
Strengths 
RelNet is an easy-to-use hydraulic modelling package that gives complementary 
hydraulic criticality indices for use with the Decision Support algorithm in the ARP 
tool. 
 
Limitations 
The current version does not support: 

• networks with over 10 000 nodes (the program may become unstable). 
 
How-to guide 

 Step 1 Create a network in Epanet. 

 Step 2 Try to run an analysis. If successful, export it to *.inp. If not, 
review your network. 

 Step 3 Once you are happy with your network analysis in Epanet you 
can proceed to run RelNet.exe. 

 Step 4 Create a separate folder for each network under the installation 
directory (example: Brno_City) 

 Step 5 Put the *.inp file into the created folder. This will become the 
working directory; you will find all the results and working files 
there. Make sure that all other files in the directory (i.e. results 
and working files of previous calculations) are deleted or 
archived elsewhere before the new calculation is started. 

 Step 6 Click Load file, locate desired *.inp file in the working 
directory and click Open. You will be notified when the file has 
been successfully loaded. 

 Step 7 Now proceed to Link processing. This step will discard one 
link of a network in each step of the analysis and create a new 
map of the network. The continuity of the network is then tested. 
If the network is not continuous, the nodes and links that are not 
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connected to a water source are discarded from the network 
diagram. The input file for the hydraulic analysis is created. A 
number of files equal to the number of links in the network will 
be generated in this step. The file mask is out.inp-link-xx, where 
xx is the index of the discarded link. Proceed to the next step. 

 Step 8 Pressure processing creates output files with the results of the 
hydraulic analysis using the EPANET 2.0. The output files are 
saved in the working directory with the following file mask: 
!out.inp-link-xx-. Each file contains the node ID and calculated 
pressure separated by a semicolon. xx is the index of the 
discarded link. Proceed to the next step.  

 Step 9 HCI (Hydraulic Critical Index) processing calculates the 
impact of each pipe link on the total network reliability. You 
have to enter a required available pressure in meters - H_req. 
This must be an integer number higher than 0. The 
recommended value is 25 (according to the local requirements). 
You also have to enter a minimum pressure H_min. If H_new is 
lower than H_min (which is the value we assume that the 
consumer demand is not satisfied at all), the amount of delivered 
water is 0 in this node. Do not enter any other characters. This 
value will be applied across all nodes. The output file with the 
calculated value of HCI is saved in the working directory with 
the input file. It has the same name as the input file, but with 
"rel" extension. An MS Excel workbook (*.xls) containing the 
HCI values is also created. 
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Brief help Failnet- Reliab 
Tool version number: 1.0.0 
Help file version number: 0.1 
Author(s): Cemagref (Patrick Eisenbeis, Olivier Piller) 
Date: 15 December 2002. Revised 7 February 2003. 
 

 
General description 
This tool aims to assess the reliability of drinking water networks and more 
specifically, calculate an Hydraulic Criticality Index at pipe level. Reliability is 
defined in the sense of water demand satisfied is the ratio of water supply available for 
consumption and water demand. 
 
The model is elaborated in two steps: 
First an hydraulic model is computed. This model is different from classical hydraulic 
models as water consumption is not fixed. Instead, it is dependent instead upon 
computed head and water demand. The Newton-Raphson method is used to solve the 
hydraulic equation and compute the outputs. 
Secondly, reliability indices are assessed. They depend on results of hydraulic models  
(with or without pipe breaks), on the weight of each node (quantity, vulnerability) and 
on pipe failure probabilities (assessed with or without forecasting models). 
 
Scope of application 
The tool is applied on hydraulically independent parts of the network, for a single 
timestep (at hourly peak demand). It will use hydraulic data at pipe or node level and 
maintenance data at either pipe category level (yearly failure rate) or pipe level (if 
individual failure risks are known). 
 
Data  
 
Pre-processing 
Two data files are necessary to use the tools:  

• an *.hdf file, defining the hydraulic links and their characteristics, and  
• an *.ndf file, defining the nodes. 

 
These files must be stored in the Failnet-Reliab program folder. Before running Failnet-
Reliab it is strongly advised to: 

• calibrate the network using a robust hydraulic model. Calibration is possible 
using Failnet-Reliab but is not so user-friendly as classical methods, 

• define pipe failure risks, either by pipe category or by pipe, 
• specify the modelling configuration, as you require it, in the file config.csv . 

 
Input data requirements (optional data items in italics) 
 
In hlf file : 
- L1   Link Identifier 
- L2   First node identifier 
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- L3   Second node identifier 
- L4   Link length (m) 
- L5   Link diameter (mm) 
- L6   Link roughness (Hazen-Williams Coefficient) 
- L7   Link equipment (optional) 
- L8   Link material (optional) 
- L9   Corresponding identifier from other tools (PHM, Poisson, …) if 
different than L1 
- L10   Annual failure rate (failure number/km/year) 
 
In ndf file : 
Ordinary links 
- N1   Node identifier 
- N2   X coordinate of the node (optional) 
- N3   Y coordinate of the node (optional) 
- N4   Node elevation 
- N5   Hourly peak demand at the node (l/s) 
- N6   Desired head at the node (obligatory if 0 in config.csv file) 
- N7   Importance of the node (=1 for all the nodes if no differentiation) 
 
Tanks 
- T1   Tank identifier 
- T2   X coordinate of the node (optional) 
- T3   Y coordinate of the node (optional) 
- T4   Node elevation (optional) 
- T5   Water level in the tank 
- T6   Minimum water level in the tank (optional) 
- T7   Maximum water level in the tank (optional) 
- T8   Tank capacity (optional) 
 
Resources 
- R1   Resource identifier 
- R2   X coordinate of the node (optional) 
- R3   Y coordinate of the node (optional) 
- R4   Node elevation (optional) 
- R5   Water level in the resource 
 
Model configuration  
The config.csv file contains data which specify the modelling options to be employed in 
the simulation. It is automatically stored in Failnet-Reliab with default data. It specifies: 
 
consideration of failure rate 0 if failure rate from config.csv used 

1 if failure rate from *.hlf file used 
desired pressure in m calculates and replaces automatically desired head 
network average failure 
rate 

number/km/year, to be used only if failure rates are not 
specified in the files 

type of model 0 if simple whole network modelling (without computing 
reliability indices)  
1 if complete modelling computing reliability indices 
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specification of MTTR Mean Time To Repair by pipe (two possible times according to 
pipe diameter 

consideration of node 
importance 

0 if node importance from config.csv used, 
1 if node importance from *.ndf file used 

 

Output data 
Output file necessary for CARE-W prototype: 
This is the file Frel_output.fnr. It provides all hydraulic criticality indices by link. 
 
Other outputs : 
srn.csv provides computed node vulnerabilities; 
Result_whole_network.csv provides results of whole-network hydraulic modelling 
(without the indices calculation). 
 
Strengths 
Compared to other hydraulic reliability tools, Failnet-Reliab computes the available 
consumption that depends on head at each node, while classical models compute only 
head at each node assuming that demand is satisfied. This modelling is closer to reality. 
 
Limitations 
The model is computed on only one timestep. It is assumed that the tanks are never 
empty (and as such, the risk of completely draining the tanks is therefore ignored). 
Pumps and other equipment cannot be included at present. Pumps should be modelled 
using a tank to specify the head downstream. Other equipment may be considered by 
applying a suitably calibrated head loss, as appropriate. 
 
How-to guide 

• Step 1 Check the calibration of the hydraulic model 
(Step 2 and 3 are concerned with the definition of config.csv) 

 
• Step 2 Define failure rates, that will be used in the indices calculation. There are 

several possibilities : 
- the same failure rate for all the pipes, 
- different failure rates by category (from Poisson Model, for instance), 
- different failure rates by pipes (from PHM Model, for instance). 

• Step 3 Define MTTR according to diameter 
• Step 4 Specify config.csv data (if necessary) 
• Step 5 Run the program Freliab and specify which input file is to be used when 

prompted. 
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Brief help CARE-W_ARP  
 
Tool version number: 1.05 
Help file version number: 1.05 
Author: INSA Lyon, France 
Date: 23 January 2003. Revised: January 2004 
 

 
General description 
Care-W_ARP tool assists end-users for the prioritisation of pipes to be included in an 
Annual Rehabilitation Programme (ARP) of a drinking water network.  
 
Two approaches are proposed to support the definition of these priorities, using 
performance thresholds or reference values: 
 

• ELECTRE TRI: an outranking method, assigning each pipe into one of 6 
possible categories; 

• HOT-SPOTS: A hot-spot is a pipe for which a criterion (a performance 
deficiency)   exceeds a threshold. 

 
The final result of the application of the CARE-W_ARP module is the proposal of pipes 
with the most positive effects not only on network performance but also on municipal 
infrastructure. Classified candidates for rehabilitation may be presented as a list of 
pipes, and/or reported in geospatial format. 
 
Scope of application 
Care-W_ARP tool analyses data at the pipe level.  
Care-W_ARP tool can be used by any end-user. The data required are at least three of 
four criteria for hundreds to thousands of pipes. 
 
Data 
 
Pre-processing 
The information needed for the calculation of criteria that are used in the multi-criteria 
decision support is imported from the Care-W central database. Types of information 
used are utility information (UI), external information (EI), performance indicators (PI), 
and additional performance measures, e.g. those calculated with hydraulic models. 
 
 
Minimum input data requirements: 
ID User reference (Pipe Id) 
L Length (m) 
D Diameter (nominal) (mm) 
PFR Predicted Failure Rate 

 
Plus information to calculate at least two criteria.  
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Optimal input data & required order  
1 ID User Reference (Pipe Id) 
2 L Length (m) 
3 M Material 
4 D Diameter (nominal) (mm) 
5 P Average Working Pressure (MPa) 
6 NPS Number of People Supplied (No. Of people connected to adjacent 

pipes between 2 valves) 
7 SC Sensitive Customer 
8 C-COS Code of category used in KB "Co-ordination score" to calculate 

Criterion "Co-ordination score" 
9 C-UCRp Code of category used in KB "Unit Cost of Repair"  to calculate 

Criterion "Annual Repair Cost" 
 C-UCRh Code of category used in KB "Unit Cost of Rehabilitation" 

Not used in ARP 1.x 
 C-RRT Code of category used in KB "Relevant Rehabilitation Techniques"

Not used in ARP 1.x 
10 C-WLI Code of category used in KB "Water Losses Index" to calculate 

Criterion "Water Losses Index" 
11 C-WQD Code of category used in KB "Water Quality Deficiencies"  to 

calculate Criterion " Water Quality Deficiencies " 
12 C-EDI Code of category used in KB "Expected Duration of Interruption" 

to calculate Criteria "Predicted Water Interruption", "Critical Water 
Interruption" & "Frequency of Water Interruption" 

 
Optimal input data table (continued) 
13 C-SFH Code of category used in KB "Sensitivity to flooding of Housing 

areas" to calculate Criterion "Damages due to Flooding in Housing 
areas" 
(or 18 & 19) 

14 C-SFI Code of category used in KB "Sensitivity to flooding of Industrial 
or commercial areas" to calculate Criterion "Damages due to 
Flooding in Industrial or commercial areas" 
(or 18 & 20) 

15 C-LS Code of category used in KB "risk of Landslides" to calculate 
Criterion "Damages due to soil movement" 

16 C-SR Code of category used in KB "Sensitivity of the road" to calculate 
Criterion "Traffic Disruption" 

17 C-SI Code of category used in KB "Sensitivity of parallel 
Infrastructures" to calculate Criterion "Damages and/or Disruption 
on other Infrastructures" 

18 C-IF Code of category used in KB "Intensity of Flooding " to calculate 
Criteria " Damages due to Flooding in Housing areas " and 
"Damages due to Flooding in Industrial or commercial areas" 

19 C-VFH Code of category used in KB "Vulnerable values in Housing areas" 
to calculate Criterion " Damages due to Flooding in Housing areas 
" 
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20 C-VFI Code of category used in KB "Vulnerable values in Industrial or 
commercial areas" to calculate Criterion "Damages due to Flooding 
in Industrial or commercial areas" 

21 Info1 Criterion calculated by an other tool (imported in CARE-W) 
22 Info2 As Info1 
23 Info3 As Info1 
24 Info4 As Info1 
25 Info5 As Info1 
26 PBR Predicted Burst Rate, used to calculate criteria: "Predicted Water 

Interruption", "Critical Water Interruption" & "Frequency of Water 
Interruption", "Damages due to Flooding in Industrial or 
commercial areas" & "Damages and/or Disruption on other 
Infrastructures" 

 if this attribute is not in the input file, these criteria are 
calculated in using PFR. 

27 PFR Predicted Failure Rate, used to calculate criteria: "Annual Repair 
Cost", "Damages due to soil movement" & "Traffic Disruption" 

28 HCI Hydraulic Criticality Index 
 

Output data 
For each pipe: 

• User Reference (Pipe Id) 
• Priority level calculated with the ELECTRE TRI method (C33 / C32 / C31 / C22 

/ C21 / C11) 
• Value of each calculated criterion 
• Hotspot (Yes / No) for each criterion 

 
Strengths 
The ELECTRE TRI procedure allows the consideration of multiple criteria without 
aggregating performances.  
 
As the number of pipes is large (hundreds or thousands) these pipes are assigned to 6 
categories (from C33, for the best options, to C11 for the less relevant options). Results 
can therefore be exported to a mapping tool using 6 colour codes. Clusters of red or 
amber pipes may be identified to organise rehabilitation programmes. 
 
Limitations 
We suggest to use ELECTRE TRI and HOT-SPOTS as two complementary decision 
support methods. HOT-SPOTS is a mono-criterion procedure, and should be used for 
critical criteria only (e.g. PCWI, DSM, …). For instance, if 99% of the studied pipes are 
given PCWI = 0 (no sensitive customers, so no predicted critical water interruptions) 
the criterion PCWI should be considered with the HOT-SPOTS procedure, and should 
not be considered in the ELECTRE TRI procedure. 
 
Depending on the number of criteria used in a study, ARP 1.x  may be unable to 
proceed with more than 5000 pipes.  
  
How-to guide 
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Step 1a: load raw data 
 

Step 1b: define rules  
(Knowledge Bases, KBs) 

(new file or  
open/edit an existing rules file) 

 
Step 1c: criteria calculation 

 

or Step 1: open an existing project 

 
 

 

Perform one simulation with the 
ELECTRE TRI procedure 

 
 define the weights of the criteria to 

be included in the multicriteria analysis 
 

 define reference profiles and 
thresholds (q, p, v) to be used in the 
ELECTRE procedure (use default or 

user defined values) 
 

 apply ELECTRE TRI in choosing 
two files: weights & profiles) 

 

 For each criterion for which you want to 
identify Hotspots: 

 
 (re-)define a threshold corresponding 

to unacceptable performance deficiencies 
 
 

   
Compare two simulations  

(sensitivity analysis) 
 

 select two simulations previously 
performed 

 

 Compare Hotspots with the results of a 
simulation done with ELECTRE TRI 
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Brief help Rehab Scenario Writer 
Tool version number: 1.0.1.1 
Help file version number: 1 
Author(s): TU Dresden 
Date: 19th June 2003 
 

 
General description 
The Rehab Scenario Writer is a software platform for developing consistent scenarios. It 
creates future background scenarios for any particular water supply company and 
opening its “window of opportunities”. The software allows the creation of consistent 
paths into the future. Five points on the time axis cover a time span from yesterday into 
the far future. Three paths – containing context information for network rehab policies, 
key factors influencing rehab policy for each point in time – open up a funnel into the 
future. Scenarios help to explore in a systematic and consistent way a whole range of 
complex future states, including paths of future developments which are rather unlikely 
to occur, but exclude those which definitely won’t take place because they are utopian. 
 
Scope of application 
The Rehab Scenario Writer supports the engineers in developing the appropriate 
rehabilitation strategy for his network. This is done by creating possible future 
background scenarios for a number of key factors where the utility is linked to. 
 
Data  
 
Pre-processing 
No data pre-processing is needed. 
 
Minimum input data requirements 
Minimum data requirements are the current values for the selected key factors. The 
following key factors are pre-defined: 

• W1 Population supplied 
• W2 Total per capita consumption 
• W3 Residential per capita consumption 
• W4 Percentage of revenue water 
• W5 Yearly water production capacity 
• W6 Annual network extension 
• W7 Pipe length per capita 
• E1 Domestic water tariff 
• E2 Industrial water tariff 
• E3 Percentage of  running costs 
• E4 Inflation rate 
• E5 Average per capita income 
• E6 Average number of persons per household 
• R1 Failure rate  
• R2 Rehabilitation rate 
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• R3 Leakage rate 
 
Optional input data  
For all selected key factors the values for one given point in the past could be entered. 
 
Output data 
A scenario project can be exported completely and imported to the CARE-W prototype. 
 
Strengths 
The software provides an easy introduction into basic scenario methodology. 
 
Limitations 
The crucial point is the “writing” of the scenarios after entering the values for the 
selected key factors and time points. The user has to picture a scenario by hand using 
the developments of the key factors for a worst, trend and best case future. 
 
How-to guide 

• Step 1 Create a new project 
• Step 3 Select the number of scenarios to create 
• Step 4 Select the pre-defined key factors for which values will be set 
• Step 5 Define the 5 time points (past, today; short term, mid term and long term 

future) 
• Step 6 Enter the values for all selected key factors and time points within every 

selected scenario 
• Step 7 Perform the consistency check and modify the values if necessary 
• Step 8 Create the output charts for the key factors 
• Step 9 Write the scenarios by hand 
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Brief help Rehabilitation Strategy Manager 
Tool version number: 3.17 
Help file version number: 3.0 
Author(s): TU Dresden 
Date: 18 July 2003 
 

 
General description 
The Rehabilitation Strategy Manager (RSM) is the further development of a software 
programme, which was developed and tested within the framework of the project 
“Quantifying future rehabilitation and replacement needs of water mains” of the 
“Research Foundation of the American Water Works Association (AWWA RF)”. It is 
based on the cohort survival model and facilitates the calculation of residual service life 
expectancies and the annual rehabilitation need of assets based on their service life 
distribution. RSM forecasts the annual length of assets, which have to be rehabilitated 
within a prognosis period determined by the user. Based on the forecast rehabilitation 
needs various rehabilitation strategies can be defined, analyzed and evaluated to find the 
appropriate one for the particular network. The calculation is based on the asset stock, 
which is defined by installation year and length and specific service life expectancies 
for different asset types. 
 
Scope of application 
RSM version 3.17 calculates the long term effects of rehabilitation strategies and 
enables the comparison of different strategies with respect to a comprehensive cost-
benefit approach to identify the “optimal” rehabilitation strategy.  
 
Data  
 
Pre-processing 
The RSM model needs the input of asset data such as length or number of assets and 
information about the according ageing process. The ageing process starts in the year of 
the pipe installation respectively the rehabilitation. Therefore this information is 
required for every part of the asset which is in use. The input of these data can be done 
manually or via an import of a text file (csv-format). 
 
Minimum input data requirements 
CW_cityin.csv 

Year Installation year 
Pipe type Name of asset type 
Length Length (m) 

 
CW_citykanew.csv Alternative input file if additional data is known. 

Year Installation year 
Pipe type Name of asset type 
Length Length (m) 
Current Failure Rate No/km*year 
Current Leakage Rate m3/km*hour 
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Additional input data  
The user has to define the ageing functions for every asset type in the project. This is 
done within the RSM model and is manually input using the menu option “Definition of 
ageing functions”. This can be done by either defining the “service life expectancy” of 
each asset type or by directly inputting “Parameter of ageing functions”. The service life 
expectancy is influenced by e.g. material, diameter, type of connection, bedding 
measurements, failure rate, installation periods. The RSM model does contain default 
values which must be modified for every project. 
 
Future rehabilitation needs and its consequences can be forecast using the “Prognosis” 
menu option. When the utility is doing an analysis of a rehabilitation strategy with 
dynamic investment calculus, additional asset data is required. This data can be 
manually input by the user in two separate menu options: 
 

• The efficiency of the rehabilitation work, carried out during the strategy period, 
will be defined in the form “Efficiency of rehabilitation”. Here, initial failure 
and leakage rates for the new rehabilitated asset types after a certain resistance 
time must be specified, together with their yearly increase. The crucial item for 
the efficiency of rehabilitation activities is the “rehab efficiency factor”. This 
factor reflects the  failure rate of the rehabilitated assets, above the average 
failure rate of the network, before replacement/renovation. A factor 3 means that 
the failure rate of a rehabilitated asset was 3 times higher than the average 
network failure rate. In addition the unit costs for the new assets have to be 
defined. 

 
• Costs for repair and maintenance and their yearly increase rates must be defined 

to estimate future repair costs as well as the discount and inflation rate. This 
information is input in the “Economic input data” form. 

 
Note that if the failure rate for each pipe in the active dataset has been calculated using a 
failure analysis and forecast tool, or total mains length and real water losses have been 
determined using the PI tool, then the current leakage rate and current failure rate for the 
dataset will be determined by the prototype. This information will be available in the 
CW_citykanewin.csv input file (see Section 3.2 above). This data can also be entered in 
the “Definition of ageing functions” section. 
 
 
Output data 
CW_cityout.csv 
Name of the RSM project 
Name of datasets (stocks) used in prognosis 
Definition of asset types: 

Asset type, Description, pessimistic 100, average 100, optimistic 100, 
pessimistic 50, average 50, optimistic 50, pessimistic 10, average 10, optimistic 
10 

3: “Rehab strategy with dynamic investment calculus”. 
Start year of prognosis, end year of prognosis 
Number of strategy periods 
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Start of period, end of period 
Strategy definition: for every strategy period and asset type the defined rehab 
length 
Asset type, Start length, End length, Complete, rehab asset type, fraction 
For every year of the prognosis: 
Year, network rehab rate (%/year), failure rate (no/km*year), savings (Euro), 
investments (Euro), length for asset type1 (m), length for asset type2, length for 
asset type3,… 

 
All of the graphs that are produced by the RSM model can be exported as Bitmap files, 
and the data used to generate the charts as text files. 
 
Strengths 
The RSM is the essential part of the extended KANEW framework for establishing 
appropriate rehabilitation programmes. With relatively few data requirements the 
engineer gets a tool which accomplishes reliable long term rehabilitation planning. The 
mathematical model has been developed for ageing processes of urban infrastructure 
networks. It is calibrated with praxis data and tested in various professional applications 
for its capability. 
 
Limitations 
Realistic estimates of the asset life-span are the most crucial model input. They must be 
based on local experience and statistics of failure and rehabilitation activities in the past 
and should reflect past and future rehabilitation policies. 
 
How-to guide 

• Step 1 Create a new project. 

• Step 2  Select “Asset type” menu option and import asset data. Select 
CW_cityin.csv or CW_Citykanew.csv in the Data folder. 

• Step 3 Define ageing functions of all assets in the project using the 
“Definition of ageing functions” menu option. 

• Step 4 Using the “Prognosis” menu option, whether to select an 
existing prognosis or to create a new one. The list of available prognoses is 
given in the drop down list at the top of the form. 

• Step 5 Define the asset stock to be used in the prognosis, as well as the 
start and end years for the analysis. 

• Step 6 Select the type of prognosis analysis to be undertaken, either 
“Forecast of future rehabilitation needs”, “Rehab strategy without dynamic 
investment calculus” or “Rehab strategy with dynamic investment calculus”. 

• Step 7 For all the rehab strategy calculations (type 2 and 3) the “future 
rehabilitation work” must be defined. The rehabilitation work can be undertaken 
over one or more periods, set by the user. For each strategy period assets will be 
rehabilitated according to the actions defined by the user. The actions are 
defined by the length of each asset which will be rehabilitated per year over the 
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period and the asset type it will be rehabilitated by. After the strategy period all 
assets that reach the end of their service life will be removed from the stock and 
replaced by new asset types according to the definitions made at the bottom of 
the form. 

• Step 8 For the third and final type of prognosis, additional data must be 
input by the user (as per section 3.3). All of the available data fields must be 
completed before an analysis can be undertaken. 

• Step 9 Click on the “light bulb” button at the top of the form to initiate 
the prognosis analysis. Once an analysis has been carried out the charts will be 
activated. A full list of the charting capacity is available in the full help file for 
the RSM. All data for these charts can be exported as either Bitmap or text files. 

• Step 10 All analysis results can be imported back to the CARE-W 
database by clicking “Export to CARE-W” button. Please note that only the 
“rehab strategy with dynamic investment calculus” results are stored in the 
CARE-W project database.  
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Brief help Rehabilitation Programme Evaluator 
Tool version number: 0.9 
Help file version number: 1st Draft version 
Author(s): TU Dresden 
Date: 19th July 2003 
 

 
General description 
The Rehab Strategy Evaluator is a tool developed by the Chair of Urban Engineering, 
TU Dresden, within the European research project CARE-W. The purpose of the tool is 
to compare various long term rehabilitation strategies, defined by the software KANEW 
(known as the Rehabilitation Strategy Manager within the CARE-W project), in order to 
find the "optimal" solution for the long term planning of the water utility. The 
methodology of Rehab Strategy Evaluator is based on the “Formalised Weighting and 
Ranking Procedure”, which was adapted to the comparison of different rehabilitation 
strategies. 
 
Scope of application 
With the Rehab Strategy Evaluator a given number of rehabilitation strategies can be 
compared and evaluated to obtain the most appropriate one.  
 
Data  
 
Pre-processing 

• The import files have to be created with the Rehab Strategy Manager. One 
import file contains one rehabilitation strategy with the following criteria to be 
compared within the Rehab Strategy Evaluator: 

• Network rehabilitation rate [%] 
• Average age of network [years] 
• Residual service life of network [years] 
• Failure rate [No./km*year] 
• Leakage rate [m³/km*h] 
• Cost savings from reduced repair [€] 
• Cost savings from reduced leakage [€] 
• Investment costs [€] 
• Year of Break Even [year] 
• Internal rate of return [%] 

 
Minimum input data requirements 
At least two strategies have to be imported for comparison.  
 
Optional input data  
Constraints for decision criteria can be given, e.g. a threshold for a maximum failure 
rate or a budget. 
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Output data 
There are no results for export available. The result of the Rehab Strategy Evaluator is 
the final ranking order of the evaluated strategies. 
 
Strengths 
The Rehab Strategy Evaluator provides a user-friendly way for the evaluation of rehab 
strategies. The underlying formalized weighing and ranking procedure can be adapted to 
similar evaluation decision problems in an easy way. 
 
Limitations 
No limitations known yet. 
 
How-to guide 

• Step 1 Create a new project or open an existing one 
• Step 2 Enter the constraints for the decision criteria 
• Step 3 Import the strategies which shall be evaluated 
• Step 4 Start the evaluation process 
• Step 5 Select the time points for which the strategies shall be evaluated 
• Step 6 Check for KO-criteria 
• Step 7 Perform an user-elimination if necessary 
• Step 8 Modify the pre-defined rankings for every criteria and check for 

dominance 
• Step 9 Perform the comparisons in pairs to estimate the final ranking order of 

strategies 
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Brief help Waterfowl 
Tool version number: 3.1.0 
Help file version number: 3.1 
Author(s): WRc, PC Care 
Date: 7 October 2002 
 

 
General description 
WATERFOWL 3 assists planning engineers in the formulation of rehabilitation 
schedules for groupings (categories) of water mains. It assesses the impact of leakage, 
repair rate and customer contacts on the cost of operating groups of distribution mains. 
A whole life costing algorithm is used to estimate the most appropriate (minimum cost) 
method (including a reactive policy) and timing for each category of pipes. It also 
provides reference material on the key techniques which are being used for 
rehabilitation of water mains.  
 
The results will be sensitive to input data such as discount rate, costing period and unit 
costs of each rehabilitation method. 
 
Scope of application 
Waterfowl typically analyses data from District Metered Areas (DMAs), comprising of 
8 to 50km or distribution mains (although larger or smaller areas may be analysed). 
Mains are grouped (into categories) by material and diameter (may be grouped further 
if defined in input data) for analysis. DMAs commonly have categories of mains laid in 
similar ground types and at similar times. Analysis of larger areas would result in a 
greater mixture of environmental variables, whereas smaller areas would normally have 
more limited data resulting in lower confidence for the calculated outputs.  
 
Data  
 
Pre-processing 
The bulk of data are input via a Waterfowl data (.wfd) ANSI text file; additional 
information from GIS can be input in MapInfo format. Full specifications for the input 
files are given in the Waterfowl help text. If burst repair and customer complaint data 
have been allocated (stored with a reference to the appropriate pipes) then GIS data are 
not required for analysis, (although it may still be desirable to read these in to enable the 
display of results geographically). 
 
Minimum input data requirements 
Main ID Unique identifier for each pipe, an attribute for both asset 

and event data unless GIS files are also being imported 

Length Length of each section of main 

Diameter Diameter of each main (inches or mm) 

Pipe material Valid entries given in help text 

Year ER lined Year pipe spray lined if applicable 
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Event ID Unique identifier for each event 

Date of event  

Event type Low flow/pressure complaint 
Low flow/pressure visit 
Aesthetic complaint 
Aesthetic visit 
Mains burst repair 
Communication pipe leak repair 
Other 

Leakage level In m3/km/day for area under investigation 

Marginal cost of water In p/m3 for area under investigation 
 
Optional input data  
Number of communication pipes for 
each category of mains. By material type 

Ground type for each pipe Valid entries given in help text 

Surface type for each pipe Valid entries given in help text 

Mains capacity adequate? y/n 

Sliplined capacity adequate? y/n 

MapInfo files for mains & events Required if Main ID has not been stored as an 
attribute for events 

Compensation payments For each category of pipes. 
 
Output data 
For each category of pipes: 

• Recommended solution/technique (including current reactive policy). 
• Timing of solution. 
• Capital cost of solution. 
• Net present cost of solution over defined timescale. 

 
Waterfowl also predicts the impact of each solution (at category and area level) on the 
following: 

• Leakage level (mains). 
• Leakage level (communication pipes). 
• Burst repair rate. 
• Customer contacts. 

 
Strengths 
Waterfowl estimates rehabilitation needs based on current (and future deteriorated) 
performance. The impacts of rehabilitation on performance are reported on with the user 
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able to override estimated solutions to ensure that critical values are not failed. It 
enables an ownership cost (in £/metre) to be attributed to each category which could 
also be used as a secondary target for prioritising rehabilitation. The experienced user 
can produce estimates of budgets required to maintain current (or acceptable) 
performance or ensure that a given budget is allocated in a manner so that benefits are 
maximised. 
 
Limitations 
Rehabilitation will by applied to the appropriate mains where water quality problems, 
hydraulic constraints or low residual asset lives are input to the model. However the 
necessary information must be input to Waterfowl. Solutions may be checked by 
reading into a hydraulic modelling package to ensure that new pipe diameters (possibly 
reduced due to sliplining) are appropriate. 
 
How-to guide 

• Step 1 View/edit ASSUMPTIONS to ensure they are appropriate for 
Utility/Area. This will include: 

o Technique costs and benefits. 
o Repair/customer contact costs.Allocation of leakage.  
o Communication pipe replacement policy.  
o Deterioration profiles to be applied. 

• Step 2 Define a new Area file, setting up discount rate and period of analysis. 
• Step 3 Read GIS (if appropriate) then Waterfowl (.wfd) file into Area. 
• Step 4 Select rehabilitation techniques to be considered. 
• Step 5 View “Area Summary” which gives an overview of the current 

performance of each category. 
• Step 6 Exclude categories from analysis if thought appropriate (e.g. newly laid 

MDPE pipe with low leakage and burst rates) to speed up analysis. 
• Step 7 Generate “Rehabilitation Schedule”. 
• Step 8 Generate “Area Map” to view results in GIS viewer. 
• Step 9 Produce “Schedule Reports” to assess results in greater detail, e.g. impact 

on burst repair and leakage rates, cost breakdowns for individual categories. 
• Step 10 Edit Schedule, to assess the costs and benefits of alternative strategies 

applied to particular categories. 
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